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Items to Be Prepared

Prepare the following before using this product.

• Protective equipment (glasses and gloves)

Use protective equipment when performing maintenance. Be sure to use a size that fits you properly.

• Anhydrous ethanol or isopropyl alcohol

Used for degreasing printed objects and cleaning the UV-LED device.

• Cloth (that is not fluffy)

Used for cleaning machines, degreasing printed objects, and cleaning the UV-LED device.

• Nozzle drop-out test paper

Used for nozzle drop-out test of print heads.

• Masking tape

Used as masking tape for securing objects and preventing ink mist. It is also used to print alignment
markers when using a smartphone camera to specify the printing position.

• Static removal brush, static removal cloth, and other static removal tools

Used when the object is charged with static electricity, such as when the temperature and humidity
are low or when printing with the protective film removed.

 RELATED LINKS 

・  P. 174 Cleaning the UV-LED devices

・  P. 27 Nozzle Drop-out Test

・  P. 77 Alignment Marker Printing
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You Can Print This Way

You can use this machine to print as shown below. We will also guide you through the steps from creating
print data to printing, so refer to this section as a reference when using this machine.

Cosmetic Items

Procedure up to Printing:Printing on Cosmetic Items(P.
89)

Golf Ball

Procedure up to Printing:Printing on Golf Balls(P. 96)

Smartphone Cases

Procedure up to Printing:Printing on Smartphone Cases(P.
103)

Acrylic Stand

Procedure up to Printing:Printing on an Acrylic Stand(P.
110)
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Features of This Machine

This machine uses UV ink and then irradiates with UV light after printing to cure and adhere the ink.

You can use the flat table to print on a range of objects, from thin paper to thick objects. This machine is
also equipped with a deodorizer to reduce the odor of the UV ink.

The differences from a generic printer are as follows:

• The print-head carriage and flat table move.

The print-head carriage (A) moves left to right (S: scan direction) and the flat table (B) moves back
and forth (F: feed direction) to print. The flat table moves up and down to adjust the printing surface
(position in height direction). However, it is not possible to print on an inclined print surface while
changing the height.

• You can set the height and printing position of the print surface.

The head gap sensor (A) detects the height of the object placed on the flat table, and then adjusts the
height of the print surface (the height direction position of the flat table) to ensure high image quality
and safe printing. You can also use the pointer (B) to precisely specify the printing area.

Introduction

Basic Information 9



Features of Inks

This machine prints using ECO-UV (EUV5) inks and primers. This section explains their respective features.

Features of ECO-UV (EUV5) Inks

This printer uses ECO-UV (EUV5) inks. ECO-UV (EUV5) inks are fixed to the object instantly by ultraviolet
light. This makes it possible to print on materials*1 that are difficult to print on using conventional inks.

This printer has one ink type in five colors (cyan, magenta, yellow, black, and white) and a primer.

Features of Primer

The primer is a colorless and transparent coating agent used as an ink base. Ink adhesion may be improved
even on materials that are difficult to print on with EUV-5 ink.

Materials that are generally difficult for ink to adhere to include the following.

• Metal

• PET (polyethylene terephthalate)

• PP (polypropylene)

• PE (polyethylene)

• Silicone

• Acrylic

• Glass

Of these, inks adhere better to metals, PET, acrylics, and glass when a primer is used. However, if the sur-
face is coated or painted with a glass coating, water repellent treatment, stain resistant treatment, or
similar, it will be difficult to improve adhesion.

It is difficult to identify any processing or treatment to the surface of a material, even if it seems to be a
material for which primer would be effective. Be sure to test print on the actual object to check ink adhe-
sion. Do not proceed with actual printing without first confirming the efficacy of the primer.

*1 Some materials and surface finishes cannot be printed on.
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Part Names and Functions

Front

TOP

No. Name Function overview

Front cover

Prevents contact with the print-head carriage and other such
fast-moving parts when the machine is operating.
This cover also reduces dust and keeps UV light and odors out.
Keep it closed except when placing objects or when performing
maintenance.

Ink slots Ink cartridges are inserted into these slots.

Head gap sensor Detects the height of the object to be printed on.

Deodorizer Eliminates UV ink odor.

Maintenance cover

Remove the maintenance cover when replacing the drain pack,
cleaning the UV-LED device, or removing and installing the op-
tional items (OA-RA-8). Keep it closed except when it is necessa-
ry to open it.

Sub power button Switches the sub power of the machine on/off.

Emergency stop button This button allows you to stop the machine immediately when it
performs an action you did not intend.

UV-LED device Shines the UV light used to cure the ink.

Print-head carriage The print heads are inside this carriage.

Pointer Illuminates in the direction of the flat table with LED light that
indicates the print origin or printing area.
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Bottom

[A] [B]

[A]: Standard Position [B]: Manual Cleaning Position

No. Name Function overview

Felt wiper Cleans the edges of the print heads after wiper operation.
Absorbs residual ink and dirt from the edges of the print heads.

Wiper Cleans the print heads.
Removes dirt and excess ink from the print heads.

Scraper Removes ink and dirt that have adhered to the wiper.

Cap top Prevents the print heads from drying out.
Seals to the print heads to protect the ink emission surface when
the print-head carriage is at the right side of the machine, such
as when waiting for printing.

Flat table Table on which the object is placed.

Drain cartridge Accumulates the discharged ink.
If the drain pack in this cartridge is full of discharged fluid, a
message prompting you to replace the pack will appear in the
Utility window. If this message appears, replace the drain pack
in the drain cartridge.

Do not place your hands on or touch the flat table or inside the machine (except for the cartridge
slots).
Doing so may cause burns.

CAUTION

Do not place any objects in front of or behind the flat table.
The flat table moves horizontally and vertically. If there is an object between the flat table and the machine, it can be
caught and cause the machine to malfunction.

CAUTION
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Side

No. Name Function overview

Ethernet connector Use this to connect an Ethernet cable.

Main power switch Switches the main power of the machine on/off.

Power-cord connector Used to connect the power cable from which power is supplied to
the machine.
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Manual Cleaning Tool

No. Name Function overview

Manual cleaning tool body (fixed part) Attach this to the machine during manual cleaning.

Cleaning part (moving parts) This is the part that moves when the cleaning stick is attached
and manual cleaning is performed.

Pad Absorbs cleaning liquid or discharged fluid that drips from the
cleaning stick.

Manual cleaning tool retaining screw Fixes the manual cleaning tool to the machine.

Do not use a manual cleaning tool that may have been deformed by striking or dropping it. Instead, replace it be-
fore cleaning.
Using a deformed manual cleaning tool may prevent manual cleaning from being carried out properly or damage the
machine.
Only attach the manual cleaning tool to the machine when performing manual cleaning work.
The machine's internal operation may cause the flat table and manual cleaning tool to come into contact, damaging the
machine and the manual cleaning tool.

IMPORTANT

• We recommend that the manual cleaning tool be left in front of the deodorizer when not in use.
• We recommend keeping the manual cleaning tool retaining screw in the area shown in the figure to prevent loss.

MEMO
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Machine State Indicated by the Sub Power Button's Lamp

The machine states are indicated with sub power button colors and flashing patterns. The sub power but-
ton allows you to check the state of the machine at a distance.

Lamp Machine state

Off Power off

Lit in green Printing

Lit in blue Object has not been set up, such as during maintenance operations.

Flashing in blue
The machine is starting or is in sleep mode.

Lit in yellow Setup of the object is completed, and it is ready for printing.

Flashing in yellow
The machine is paused.

Lit in red When an abnormality occurs in the machine, or when the emergency stop but-
ton is pressed.
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Object to Be Printed On

In this manual, the objects to be printed are called the "object" or "media." Although this machine can
print on a variety of objects, from thin paper to thicker materials, there are some regarding the object
that you should take into consideration.

Objects that Can Be Set Up

The conditions for objects that can be set up in the machine are shown below.

Size and Weight

The printable range differs from the printable object to be set up. You can set up objects that are larger
than the Printable Area.

W

L

Maximum size

Width (W) 240 mm (9.45 in.)

Length (L) 178 mm (7.01 in.)

Thickness 102 mm (4.02 in.)*1

Maximum weight 3 kg (6.61 lb.)

 

*1 • Except when using the optional rotary axis unit.
• Depending on the object, it may be possible to print up to 107 mm (4.21 in.).

 

Materials, Shapes, and Similar Parameters

Although this machine can print on many materials, be sure to test print and then check the ink adhesion
before printing the final print. In addition, to protect the print heads and ensure print quality, the follow-
ing objects cannot be printed on.

• Mirrors, stainless steel, and other objects that are likely to reflect UV light

These objects promote the curing of the surface of the print heads and therefore cannot be used.

• Objects that are charged with static electricity

Static electricity can cause the ink to splatter, adversely impacting printing results and the print
heads.

• Objects with significant unevenness on the print surface

The greater the distance between the print heads and the print surface, the worse the printing re-
sults. The difference between the highest and lowest print surfaces should be approximately 2 mm
(0.08 in.) or less.

• Objects that easily become loose

If the object (A) is not firmly held in place, the head gap sensor (B) cannot detect the height correctly.
Be sure to secure the object to be printed on firmly in place. If the media becomes loose, you can use
masking tape or similar to hold the media in place.
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A B
• Objects made from soft material

If the object (A) is made from soft material, the pressure it applies on the head gap sensor (B) is too
weak. This prevents its height from being detected correctly.

A B

Depending on the type of object to print on and the installation method, the height may not be set correctly. The ma-
chine may malfunction if printing is performed when an incorrect installation method is used or if printing is performed
on an inappropriate material.

IMPORTANT
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Printable Area

The maximum printable area is as follows.

W

L

Width (W) 210 mm (8.2 in.)

Length (L) 148 mm (5.83 in.)

Height 0 to 102 mm (0 to 4.02 in.)*1

 

*1 • Except when using the optional rotary axis unit.
• Depending on the object, it may be possible to print up to 107 mm (4.21 in.).

 

Front/Back/Left/Right Printing Area

The area within the white border of the flat table is the approximate maximum printing area. The ma-
chine uses the lower right of the flat table as the 0 point (A) and then 0 mm (0 in.) in the S: scan direction
and 0 mm (0 in.) in the F: feed direction. The upper left corner (B) of the flat table is S: 210 mm (8.26 in.)
and F: 148 mm (5.82 in.), and the area between these two points is the maximum printing area.

S:Scan

F:Feed

S and F set in Utility indicate the coordinates of the flat table. The printing area set based on the print
origin (C) and the upper left corner (D) is displayed as "W" (length in the S direction) and "L" (length in the
F direction). In the case shown in the following figure, if C (S: 110 mm [4.33 in.], F: 70 mm [2.76 in.]) and
D (S: 210 mm [8.27 in.], F: 148 mm [5.83 in.]) are used, the printing area is W: 100 mm (3.93 in.) and L: 78
mm (3.07 in.). The minimum settable printing area is W: 25.4 mm (1 in.) and L: 25.4 mm (1 in.).
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W

L

Printing Area in the Height Direction

The printing area is within 2 mm (0.08 in.) (b) from the highest printing position (a) of the object. Printing
positions (c) that are 2 mm (0.08 in.) or lower are not recommended due to lower print quality.

ba

c

However, print quality may improve depending on the settings at the time of printing. Set the following
based on the height of the print surface.

• [General] or [Text Decoration]: Difference in height of printed surface is within 2 mm (0.08 in.)

• [Generic Distance]: 2 mm to 6 mm (0.08 in. to 0.23 in.) difference in height of printed surface (2 mm
to 4 mm [0.08 in. to 0.15 in.] if Wh is included in the printing)
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Orientation of Object and Print Data

Print data is printed with the data rotated 180 degrees. When setting up the object in the machine, rotate
it 180° relative to the print data.

Print data Object (after printing)

Introduction
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Considering a Jig

As the distance between the object and the print heads increases, the likelihood of ink mist*1 increases.
Therefore, a jig might be required according to the size and shape of the object to be printed on. Prepare
a jig if one of the following conditions is met.

If it is difficult to obtain a jig, cover the sides of the object with masking tape or similar to avoid adhesion
of ink mist.

When with just the object, no margins can be secured in the areas 40 mm (1.57 in.) to both the
front/back and left/right of the portion of the data to be printed

Print heads Data area

Object to be printed on Margin: 40 mm (1.57 in.) or more

Jig Less than 2 mm (78.7 mil) in height difference from the
actual print surface

 
 

The variation in height of the surface of the object is 2 mm (0.08 in.) or more

Print heads Data area

Object to be printed on Margin: 40 mm (1.57 in.) or more

Jig Less than 2 mm (78.7 mil) in height difference from the
actual print surface

 
 

*1 Fine particles of ink are scattered in areas other than the printing area.
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Object (Media) Registration Items

Set the following items to set up the object.

Object Type

Select from [Transparent] or [Opaque]. For colored transparent objects, select based on the following cri-
teria.

• [Transparent]: A hand placed on the other side of the object can be seen through it.

If the object is transparent, select [Smartphone Cases] or [Others] from the items in the [Transpar-
ent]pull-down menu in the [Object Type] window.

• [Opaque]: A hand placed on the other side of the object cannot be seen through it.

The [Transparent] and [Opaque] selections affect automatic maintenance. The standard setting [Transparent] requires
more frequent maintenance*1 to protect the print heads than [Opaque], and therefore consumes more ink. Proper se-
lection of [Transparent]/[Opaque] can reduce ink consumption and prevent poor printing quality.

IMPORTANT

Flat table height

Set the printing position in the height direction.

Print Origin

Set the point that will serve as the base printing position. Select one of the following.

• [Origin Relative]: Sets the lower-right corner of the printing area as the base printing position.

• [Center Relative]: Sets the center of the printing area as the base printing position.

Printing Area

The printing area should be set after the flat table height is set. Attempting to set the printing area first may result in
the object coming into contact with the head gap sensor, which may damage the head gap sensor.

IMPORTANT

Specify the area in which to print. There are two ways to set the area depending on the print origin.

• When [Origin Relative] is set for [Print Origin]: If you specify the lower right corner (A) of the preview
window in Utility, the space between the end point (B)*2 is set as the printing area.

• When [Center Relative] is set for [Print Origin]: The maximum printing area is set around the center
of the printable area (S: 105 mm [4.13 in.], F: 74 mm [2.91 in.]).

*1 Performs cleaning using ink.
*2 Upper left of printable area (S: 210 mm [8.27 in.], F: 148 mm [5.83 in.])
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When changing the [Center Relative] position, narrow the printing area before changing the position. Then specify
the printing area according to the print data.

MEMO
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Composition and Role of Software Used in the Machine

The machine is operated by Utility, which is started from the Roland DG Connect Hub. Creation of print
data, processing (resizing, decorations such as text and pattern), detailed settings, and printing are per-
formed using FlexiDESIGNER VersaSTUDIO Edition, but the actual print data is generated using VersaWorks.

Composition

BD Utility

FlexiDESIGNER 
VersaSTUDIO Edition

(VersaWorks)

Roland DG
Connect Hub

[Utility]

This software displays the printer status and configures the printer settings. It mainly performs the follow-
ing operations.

• Setting and adjustment functions

• Management of ink remaining amount

• Maintenance function

• Display of messages and error messages
[FlexiDESIGNER VersaSTUDIO Edition]*1

This software handles everything from the creation of print data to printing.
[VersaWorks]

This software converts print data into data that can be printed using a printer.

When FlexiDESIGNER is started, VersaWorks is launched along with it, but when printing from FlexiDESIGN-
ER, this software is not operated directly. However, since VersaWorks is generating the print data, it should
be left running when printing.

When print data is created by utilizing existing data (.ai, .pdf, etc.) or by using commercially available application soft-
ware*2, VersaWorks is used to make the necessary settings for printing, and then perform printing.

MEMO

 RELATED LINKS 

・ VersaWorks Help

*1 Hereinafter referred to as "FlexiDESIGNER."
*2 Software for creating vector graphics such as Adobe Illustrator and CorelDRAW.
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Head Gap Sensor

The head gap sensor is an important sensor that detects the height of the object. Improper setup of the
object to be printed or problems with the way the object is secured may result in damage to the head gap
sensor.

Object Height Detection Method

The flat table (A) moves from the back to the front and the head gap sensor (B) comes into contact with
the object (C) to detect the height of the object.

Risk of Head Gap Sensor Damage

After detecting the height of the object, the clearance between the object (A) and the head gap sensor

(B) is set to 0.5 mm (0.02 in.).

However, note that the following operations or situations may cause the object to come in contact with
the head gap sensor and damage it.

• The top point of the object is higher than the head gap sensor.

• The flat table is moved from front to back in an attempt to set the printing zone before setting
the height of the object.

• Media with a lower height than the installed object is selected, and the printing area is set and
printing begins without the user noticing the selection error.

• The flat table is moved from the front to the back while the object is not firmly secured to the
flat table (i.e., the height of the object may change).

• After fixing a warped object with tape and setting the height, the tape partially peels off due to
the warping, and the object strikes the head gap sensor when the flat table moves.

• The rotary axis unit is not recognized.

• The rotary axis unit is installed on the flat table, but the connector of the rotary axis unit is not
connected to the main unit or is not connected correctly.
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Deodorizer

Since UV ink has an odor that may affect the human body, this machine is equipped with a deodorizer.

The deodorizer has four modes, as shown in the table below. Since there is a trade-off between the service
life of the filter and its deodorizing performance, use the filter as appropriate for your usage situation.

Deodorizing performance varies depending on the mode and suction power. Each mode has a default suc-
tion power setting, which can then be set from 20% to 100% in 10% increments.

For information about purchasing filters, contact your authorized dealer or visit our website.

Mode Deodorizing performance Suction power default settings

[Strong]

Activated when main power is on, sub power is on, or during printing.
This setting emits the least amount of odor to the exterior of the ma-
chine. This mode reduces odors coming out of openings in the machine
even when the machine is not in use.
In this mode, you can set the pause time for the deodorizer.

• [When Printing]: 50%
• [When Sub Power On]: 40%
• [When Main Power On]: 20%

[Medium]
Activated when sub power is on, or during printing. This mode reduces
odors when the front cover is opened during operations such as loading
objects.

• [When Printing]: 50%
• [When Sub Power On]: 40%

[Weak]*1
Activated only during printing. This mode is intended for users in back-
yards and other areas that are normally unoccupied and well-ventilat-
ed.

• [When Printing]: 50%

[Off] Deodorizing not activated. －

 

*1 Default settings
 

• Recommended Filter Replacement Time

• Once every year.
However, the deodorizing performance decreases with frequency of use. If you start to smell odors coming from
near the machine, replace the filter even if it has been in use for less than a year.

MEMO

 RELATED LINKS 

・  P. 132 Setting the Deodorizer Mode

・  P. 133 Setting the Deodorizer Pause Time (Strong Mode Only)

・  P. 202 Replacing the Deodorizer Filter

・ Roland DG Website
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Nozzle Drop-out Test

Test Pattern and Details Checked

Before printing, perform a nozzle drop-out test (print a test pattern). The printing size for the test pattern
is approximately 90 × 51 mm (3.54 in. × 2.01 in.) (landscape).

If you prepare a landscape A5 size (210 mm × 148 mm (8.27 in. × 5.83 in.) paper as the media, you can
perform nozzle drop-out tests in up to four locations on a single sheet of media.

Print the test pattern using inks as indicated in the sequence below. You can check if the print heads are
functioning normally.

The primer (Pr) and white (Wh) in this figure are deliberately made gray, but the actual test pattern Pr is printed trans-
parent and Wh is printed white. These two will be harder to see than the following figure when printed on white media.

MEMO

Wh Pr WhPrY M K C

Make sure that the lines of each color are clear and evenly aligned. Missing sections in the test pattern
indicate "dot drop-out," while a collapsed or sloping test pattern indicates "dot displacement." Such issues
can be improved by eliminating the nozzle clogging. For this reason, several cleaning menus have been
provided.

Test Paper

The nozzle drop-out test is a task that should be performed frequently. If a problem is found by checking
the test pattern, cleaning is performed and the nozzle drop-out test is performed again. Because of this,
ease of checking and ease of loading media are important. The ease of checking depends on the color of
the media.

To check the test pattern without removing the media and perform the nozzle drop-out test again after
cleaning, the [Print Origin] must be set again.

Media Color

Media color Features

Transparent

Since the flat table is black, check the test pattern by removing the nozzle drop-out test paper. Pr is trans-
parent, but you can check it by its light transmission state. Once the media is removed, all colors can be
easily checked.
Some media are weakly adhesive and easy to reapply.

White CMYK inks can be checked while media are attached to the flat table. Wh and Pr can be checked by removing
them and changing the angle at which they are exposed to light.
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Media color Features

Black Wh can be checked while media are attached to the flat table. All except Wh can be checked by removing
the media and changing the angle at which it is exposed to light.

Silver It is relatively easy to check the test patterns for all colors with the media attached to the flat table. A
matte finish makes it even easier to check.

How to Secure the Media

How to secure the
media

Features

Tape

Fix the four corners or the entire circumference of the media with masking tape or similar. Tape the media
closely to the flat table so that the media does not become loose. Apply the tape itself so that it does not
become lifted or overlapped, creating a difference in height.
If you remove the media and then check the test pattern, reloading it will require the same amount of time
and effort as the first time.

Double-sided tape

Apply thin double-sided tape to all sides of the media and secure it to the flat table. Apply the double-sided
tape starting from the edges so that the media does not become wrinkled or loose.
When removing the media, be careful not to leave any double-sided tape on the flat table. Reloading is eas-
ier than with ordinary tape.

Media with weak ad-
hesive sheet

Both loading and removing can be done easily.
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Alignment by Camera Image

You can use your smartphone's camera to specify the printing position on the object before printing.

The flow of this operation is as follows.

1. Print the printing markers for detecting positions on the flat table.

2. Place the object on the flat table, and then take a picture of it with your smartphone.

3. Transfer the captured image data to your computer, and then import it with FlexiDESIGNER.

4. Position the print data on the image data and print it.

Compared to the usual printing method, in which the printing area is set by placing the object with refer-
ence to the white border of the flat table, alignment is easier since the position is specified from the im-
ported image data. In addition, you can create print data with an image of the finished product in mind.

However, the printing position may misalign when printing on thicker objects or depending on the angle at
which the pictures taken with the camera. Therefore, it is not suitable for printing over the entire printing
area. We recommend using this method to print a small single point on a large printing area.

For details on this work, refer to Determining the Printing Position Using Captured Images.
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Recommended Settings

Introduction

• Language settings and date/time settings

• Language settings:Setting the Language(P. 136)

• Date/time settings:Adjusting the Date and Time(P. 135)

• Deodorizer settings

• Pausing and Resuming Printing(P. 59)

• Length and temperature units

• Changing the Units of Measurement(P. 142)

• Nozzle drop-out test paper registration

• Registering and Setting Up the Nozzle Drop-out Test Paper(P. 31)

Once You Are Experienced

• Printing movement range

• Minimizing Print-head Carriage Movement(P. 120)

• Clearance mode

• Setting a Longer Distance between the Object and the Print Heads(P. 126)

• Readjusting Height during Printing(P. 123)

• Ink circulation interval

• Setting the [Ink Circulation] Interval(P. 129)

• Sleep time

• Setting the Activation Interval for Sleep Mode (Power-saving Feature)(P. 134)
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Registering and Setting Up the Nozzle Drop-out Test Paper

We recommend registering the media to be used for the nozzle drop-out test in order to operate the ma-
chine efficiently.

If you register a landscape A5 size (210 mm × 148 mm [8.27 in. × 5.83 in.]) paper as the media, you can
perform nozzle drop-out tests in up to four locations on a single sheet of media by changing the [Print
Origin].

Procedure

1. Press the sub power button.

P. 51 Turn on the sub power

2. Open the front cover.

3. Pull out the white ink cartridge and mix it.

Shake it about 50 times (for approximately 20 seconds), and then reinsert it.

P. 163 Maintenance of Ink Cartridges

4. Load the nozzle drop-out test paper.

The area inside the white line (A) is the approximate maximum printing area. Place and secure the
media in alignment with the white frame. Secure it here with tape.

5. Close the front cover.

6. On the Utility home screen, click [Setup].

7. Click .
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In Utility, "media" is used on the window used to register/manage objects.

MEMO

8. Enter a name that you will recognize as being for the nozzle drop-out test, and then click [OK].

Previously registered media names cannot be used.

9. Select [Opaque] on the [Object Type] window, and then click [OK].

10. Click [Change] next to [Flat Table Height], and then set the height of the nozzle drop-out test paper.

(1) Click  or  on the right side of the window to align the nozzle drop-out test paper on

the flat table with the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the single-
click moving distance.

MEMO

(2) Click  on the left side of the window to move the nozzle drop-out test paper on the flat table

closer to the head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from the
head gap sensor without coming into contact with the head gap sensor.

a

(3) Click [Automatic Setup].

The flat table moves and the head gap sensor detects the nozzle drop-out test paper.

(4) Click [OK].
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11. Click [Change] next to [Print Origin] and [Printing Area], and set range of the nozzle drop-out test.

The printing size for the nozzle drop-out test is approximately 90 mm × 51 mm (3.54 in. × 2.01 in.)
(landscape).

When the [Printing Area] setting is finished, the print-head carriage returns to its original position after it has
been left in the same position for approximately 3 minutes to prevent the print heads from drying out. Per-
form the procedure again.

MEMO

(1) Select [Pointer] for [Position Specification].

The print-head carriage moves, and then the pointer on the right side of the print-head car-
riage illuminates the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]) of the maximum printing
area.

(2) Click , , , or , and then move the pointer to specify the print origin (low-

er right of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the for-
ward-backward direction. The position that the pointer illuminates serves as the print origin.

(3) Click [OK].

Returns to the [Flat Table Height], [Print Origin], and [Printing Area] settings window.

About [Printing Area]
Since the [Print Origin] is unchanged and the [Origin Relative] is specified here, the upper left of the printing
area is automatically set to the maximum position (S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

MEMO

12. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.

The nozzle drop-out test paper is now registered and set up.

If you are printing continuously on the same media, such as when performing a nozzle drop-out test followed by clean-
ing and then another nozzle drop-out test, click , and then change the print origin registered in [List of Media Set-
tings].

MEMO
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 RELATED LINKS 

・  P. 27 Nozzle Drop-out Test

・  P. 64 Performing a Nozzle Drop-out Test
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Starting/Exiting Utility

Starting Utility

Procedure

1. Click the Roland DG Connect Hub icon in the notification area.

2. Click the machine to use.

The applications that can be used with the selected machine are displayed on the right side of the
screen.

3. Click [Open] for Utility.

Utility starts, and then the following window is displayed.
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Utility
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Exiting Utility

Procedure

1. Click  in the upper-right corner of the Utility window.

2. In the confirmation window, click [OK].

Exit Utility.
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Utility Home Screen

Utility is software that displays the printer status, configures the printer settings, and performs printer op-
erations.

No. Name Details

Status bar Displays the printer status and indicates the next
operation.

Notifications Displays important information.
When there are notifications, their number is dis-
played on the icon.

Menu Use this to configure printer settings.

Media information Displays the object information.
Once the object is set up*1, the name of the object
is displayed.

Amount of ink remaining and amount of discharged
fluid

Displays the amount of ink remaining in each ink
cartridge and the amount of discharged fluid in the
drain pack.

If it is time to replace a color,  is displayed next

to the corresponding ink cartridge. Click this icon
to display the detailed information for the ink.

Printing area and height Once the object is set up, the set printing area (W:
width, L: length, H: height*2) is displayed.

[Setup]/[Cancel Setup] Starts/cancels setting up the object to be printed
on.

[Cleaning] Displays the menu related to the nozzle drop-out
test and cleaning.

Sub power Operate the machine's sub power supply with Utili-
ty.

 

*1 Setup refers to placing the object on the flat table, setting the printing area and printing height, and making the object ready
for printing.
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*2 You can select the flat table position from [Flat Table Height] (H) and [Object Thickness] (T).
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Menu List

Click  to display the [Menu] window.

[List of Media Settings]

In Utility, the window that lists the setting values of objects is called the [List of Media Settings].

MEMO

This window displays the setting information of the object that has been set up. This window is not dis-
played if the object has not been set up.

You can check and change*1 the setting values when registering the objects. To the right of [Print Origin]
is an item to be set when changing the [Origin Relative]. It is not a setting for this media.

For more information, refer to Object (Media) Registration Items.

[Printing Zone]

[Flat Table Height]

The height direction position to be printed is displayed.

[Print Origin]

The point that will serve as the base for printing position is displayed as the distance from the lower right
reference point (S: 0 mm [0 in.], F: 0 mm [0 in.]) on the flat table.

[Printing Area]

The area to print that uses the print origin as the base is displayed in the distance (mm) in the W:S direc-
tion and then in the distance (mm) in the L:F direction.

[Flat Table Lowering Amount]

The setting values for how far down from the standard flat table position to print are displayed.

[Object Type]

[Transparent] or [Opaque] is displayed.

[Printing Movement Range]

The operation width of the print-head carriage when printing is displayed as either [Output Data Width],
[Media Width], or [Full Width].

*1 You cannot change [Flat Table Height] and [Flat Table Lowering Amount].
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[Media Width] will be the width set for the printing area.

MEMO

 RELATED LINKS 

・  P. 126 Setting a Longer Distance between the Object and the Print Heads

・  P. 120 Minimizing Print-head Carriage Movement
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[Media Management]

In Utility, the window for managing objects is referred to as [Media Management], and objects are referred to as "me-
dia."

MEMO

You can save up to 50 objects. The  icon indicates a normal object and the  icon indicates an object

for the rotation shaft unit.

You can select registered media to review, duplicate, delete, or take other action for setting details.

:[Display Media Settings]

Displays the details set for the registered media.

: [Duplicate Media]

Duplicate the setting details of the registered media and then register it as separate media.

: [Change Media Name]

Changes the name of the registered media.

: [Delete Media]

Deletes the registered media that is selected.

Search Function and Favorites Function

You can search for a media name with the search box. Furthermore, you can set commonly used media as
favorites and display only these favorites. You can also search while favorites are displayed.

1. Click  next to a media name to change this icon to .

2. Click  next to the search box.

The icon changes to , and the list of media set as favorites appears.

Click  again to display the list of all media.
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[Maintenance]

Use this to replace consumable parts and perform other maintenance.

Click  to view a related video. We recommend that you view this video to understand the overall flow
of work.

[Cleaning]
UV Lamp Manual Cleaning

Click [Execute] to switch to the [UV Lamp Manual Cleaning] execution screen. Follow the instructions
shown on the screen to clean the UV lamp.

[Parts Replacement]
Wiper

Click [Execute] to switch to [Wiper Replacement] execution screen. Follow the on-screen instructions to
replace the wiper.
Felt Wiper

Click [Execute] to switch to [Felt Wiper Replacement] execution screen. Follow the on-screen instruc-
tions to replace the felt wiper.
Cap Top

Click [Execute] to switch to [Cap Top Replacement] execution screen. Follow the on-screen instructions
to replace the cap top.

Ink
Ink Circulation

Circulates ink to prevent uneven color issues with white ink. Click [Execute] to start [Ink Circulation].
Ink Renewal

When ink circulation does not correct the unevenness of the white ink color, replace (refresh) the white
ink. Click [Execute] to start [Ink Renewal].

[Ink Discharge]

Performs in advance the ink discharge which is otherwise performed regularly. For normal use, it is not
necessary for the user to execute this. Click [Execute] to start [Ink Discharge].

 RELATED LINKS 

・  P. 174 Cleaning the UV-LED devices

・  P. 192 Replacing the Wiper

・  P. 194 Replacing the Felt Wiper
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・  P. 196 Replacing the Cap Top

・  P. 182 Ink Renewal

・  P. 183 Ink Discharge
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[Preferences]

Change the operation settings of the machine to match the usage environment.

Click  to view a related video. We recommend that you view this video to understand the overall flow
of work.

[Clearance Settings]

Sets the action to be taken when a height error occurs during printing. Select from [Stop] or [Readjust].

If [Readjust] was selected, set the amount to lower the flat table in [Maximum Value (Threshold)].

[Deodorizer Settings]

Changes the deodorizer mode. Select from [Strong], [Medium], [Weak], or [Off].

You can also set the suction power for each mode.

[Flat Table Height/Object (Media) Thickness]

Changes the height direction reference. Select from [Height (Lowered Flat Table Treated as Height of 0)]
or [Thickness (Raised Flat Table Treated as Thickness of 0)].

[Operation before Printing]

Set whether to check the height of the object after the object is set up and before printing starts.

[Ink Circulation Interval]

Sets the frequency of white ink circulation to prevent uneven color issues. Select from 30 to 360 minutes
in increments of 30 minutes.

[Sleep Time]

Sets the time until sleep mode (the state in which the power-saving features operate) activates. Select
from 15 to 120 minutes in increments of 15 minutes.

[Date and Time]

Changes the date and time printed on the nozzle drop-out test.
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[Alignment Marker Printing]

Prints alignment markers over the flat table. Set up tape for alignment markers or similar to enable [Exe-
cute].

[Rotary Unit Attachment/Removal]

This is used when attaching/removing the rotary axis unit.

[Initialize Settings]

Clicking [Execute] returns [List of Media Settings], [Preferences], and [Network] to their factory default
values. However, [Position Adjustment] will not be initialized.

[Position Adjustment]

• [Adjust Manual Cleaning Tool Position]

Adjusts the position when the manual cleaning tool is changed.

[Execute] is not enabled when the object is set up. Cancel the setup, and then remove the object.

• [Adjust Pointer Position]

Adjusts the misalignment between the printing area and the pointer position.

Set up media for pointer position adjustment to enable [Execute].

 RELATED LINKS 

・  P. 122 Flat Table Height Setting

・  P. 132 Setting the Deodorizer Mode

・  P. 129 Setting the [Ink Circulation] Interval

・  P. 135 Adjusting the Date and Time

・  P. 77 Alignment Marker Printing

・  P. 131 Removing/Attaching Optional Items (OA-RA-8)

・  P. 137 Setting the Base Position of the Manual Cleaning Tool
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[System Information]

You can use this window to check the machine and network information.

[Machine Information]

You can check the following information:

• [Model]

• [Nickname]

• [Serial Number]

• [Ink Type]

• [Firmware Version]

• [MAC Address]

[Network]

You can check and edit the network settings of the connected machine.

Turn on [Obtain IP Address Automatically] to automatically obtain the machine's IP address, subnet mask,
and default gateway.

• [IP Address]

• [Subnet Mask]

• [Default Gateway]

[Units]

Sets the [Length] and [Temperature].

[Language]

Sets the display language.

[Version]

Displays the Utility version information.
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This section explains the workflow of daily operations.

Performing appropriate maintenance at the correct times can help prevent malfunction as well as bring
out the full potential of this machine.

Workflow

This section provides an example workflow for a store that prints immediately after an order is placed.

Before Opening

1. Mix the white ink.Maintenance of Ink Cartridges(P. 163)

2. Turn on the sub power of the main unit.Turn on the sub power(P. 51)

3. Start Utility.Starting Utility(P. 35)

4. Check the notifications.

Perform maintenance according to the notifications.Notifications(P. 230)

5. Perform a nozzle drop-out test.Step 1: Performing a Nozzle Drop-out Test(P. 64)

6. Take action as appropriate for the test pattern results.

• Good: Finish machine standby

• Bad: Implement normal cleaningStep 2: Performing Normal Cleaning(P. 66)

Business Hours

Print when the order for printing is placed.Step 4: Perform Printing(P. 76)

If a message is displayed in Utility, take action as indicated in the window. The following are messages that
frequently appear in notifications.

• [The time for ink mixing has arrived.]

This message prompts the user to mix the white ink cartridge.Maintenance of Ink Cartridges(P. 163)

• [The time for manual cleaning has arrived.]

This message appears when it is time to clean using the manual cleaning tool.Manual Cleaning Meth-
od(P. 168)

There are several other maintenance notifications. Be sure to always check notifications in Utility: .

After Closing

1. Check that there are no maintenance notifications.Notifications(P. 230)

2. Clean the machine.Cleaning the Machine(P. 164)

3. Switch off the sub power.Turn off the sub power(P. 53)

4. Exit Utility.Exiting Utility(P. 37)

Daily Overall Flow
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Always keep the main power switched on. Turn the sub power on before use and turn it off after use.

Main Power On

After the sub power is turned on, the unit will enter sleep mode after a certain period of inactivity. See
the following for information on how to recover from sleep mode.

P. 54 Sleep Mode (Power-saving Feature)

• Always keep the main power switched on.
Never switch off the main power. Leaving the main power enables automatic maintenance to be carried out periodi-
cally. If the automatic maintenance is not carried out, it may result in the breakdown of this machine, such as the
breakdown of the print heads.

• Never switch off the main power or unplug the power cord suddenly while operation is in progress.
Switching off the main power or unplugging the power cord suddenly while operation is in progress may damage the
print heads or otherwise cause the machine to fail.

IMPORTANT

What about when turning the main power off?
When it is necessary to turn off the main power, such as during transfer, be sure to turn off the sub power before turn-
ing off the main power. Then promptly turn on the main power.

MEMO
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Turn on the sub power

You can switch the sub power on with a button on the machine or an icon in Utility.

Turning On the Sub Power with the Button on the Machine

Procedure

1. Ensure that the maintenance cover and front cover are closed and that the main power is on.

2. Press the sub power button.

The sub power is switched on. When the sub power button changes from flashing blue to steady
blue, startup is finished.

If the main power is off, turn the main power on to start firmware initialization. There will be no response
when pressing the sub power button until initialization is complete. In this case, wait some time before press-
ing the sub power button.

MEMO
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Turning On the Sub Power of the Machine with Utility

Procedure

1. Ensure that the maintenance cover and front cover are closed and that the main power is on.

2. Start Utility.

P. 35 Starting Utility

3. Click .

The sub power is switched on. When the machine's sub power is turned on, the icon changes to

.

If the main power is off, turn the main power on to start firmware initialization. There will be no response

when  is pressed until initialization is complete. In this case, wait some time before pressing the sub

power button.

MEMO

Once the sub power is turned on, the Utility home screen is displayed.
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Turn off the sub power

You can switch the sub power off with a button on the machine and an icon in the Utility window.

Turning Off the Sub Power with the Button on the Machine

Procedure

1. When you're finished working, hold down the sub power button for 1 second or longer.

When the sub power button darkens, the sub power is switched off.

Turning Off the Sub Power of the Machine with Utility

Procedure

1. When the work is finished, click  on Utility.

2. When the [Turn off sub power.] window appears, click [OK].

After some time, [The sub power is off.] is displayed on the Utility status bar, and the sub power

icon changes to .
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Sleep Mode (Power-saving Feature)

This machine is provided with a power-saving feature that switches to a low-power "sleep mode" when a
fixed interval passes with no operation.

When the machine is in the sleep mode, the sub power button flashes in blue slowly. Recover from the
sleep mode by performing one of the following operations.

• Press the sub power button.

• Open the front cover.

• Click [Recover] in Utility.

• Send the print data from the computer (with the object set up).

• Default setting: [30 min]

MEMO

 RELATED LINKS 

・  P. 134 Setting the Activation Interval for Sleep Mode (Power-saving Feature)
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Turning the Power Off During Emergencies

The print-head carriage and flat table may operate automatically during setup, maintenance, or other op-
erations even when the front cover of the machine is open.

If the print-head carriage or flat table starts to move unexpectedly and your hand or an object is about to
be caught in it, press the emergency stop button to stop the printer operation.

When the emergency stop button is activated, you will be notified with [Emergency Stop Error] in Utility.

If the print heads are stopped in a position where they are separated from the print head caps, they
should be restored to their original position within 10 minutes to prevent them from drying out.

See [Emergency Stop Error] for more information on how to restore the print heads to their original posi-
tion.

Power Supply Operations
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Opening/Closing the Front Cover

Most operations, such as setting up objects, removing and attaching ink cartridges, and maintenance, are
performed with the front cover open. To reduce odors and prevent the print heads from drying out, keep
the front cover closed except when opening it is necessary.

Procedure

1. Make sure there are no foreign objects on the top of the front cover.

When opening the front cover, do not place hands or objects in the area shown in the fig-
ure.
Doing so may result in injury from pinching fingers or damage to the front cover.

CAUTION

2. Hold the position shown in the figure and open the front cover.

3. Perform the necessary work.

4. Check the following before closing the front cover.

• A: There are no foreign objects between the front cover and the machine

Opening/Closing the Cover
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• B: The maintenance cover is installed

5. Close the front cover.

Opening/Closing the Cover

Basic Operations 57



Attaching/Removing the Maintenance Cover

Work performed with the maintenance cover removed includes replacing discharged fluid packs, removing
and installing optional items and stored fixtures, and similar tasks. Keep the maintenance cover securely
attached except when necessary.

Procedure

1. Open the front cover.

P. 56 Opening/Closing the Front Cover

2. Remove the maintenance cover according to the following procedure.

(1) Hold the underside of the maintenance cover, and pull it approximately 30 mm (1.18 in.) towards
you.

(2) Lift the maintenance cover up to remove it.

3. Perform the necessary work.

4. Attach the maintenance cover according to the following procedure.

(1) Insert the hooks (B) on the maintenance cover into the grooves on the left and right (A).

(2) Press the maintenance cover against the machine.

Make sure the maintenance cover is secured by the magnets (C).

5. Close the front cover.

Opening/Closing the Cover
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Printing can be paused or stopped midway through printing, but restarting after a pause will affect print
quality.

Pausing and Resuming Printing

We do not recommend resuming printing after pausing, as it will affect the print quality, such as by causing horizontal
stripes to appear at the position where printing was paused.

IMPORTANT

Procedure

1. Click [Pause] on the Utility home screen while printing.

Printing pauses.

You cannot operate the home screen while the menu screen is displayed. Close the menu screen.

MEMO

2. Click [Resume].

Printing resumes.

Pausing and Canceling Printing
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Canceling Printing

Canceling Printing with Utility

Procedure

1. Click [Pause] on the Utility home screen while printing.

Printing pauses.

You cannot operate the home screen while the menu screen is displayed. Close the menu screen.

MEMO

2. Click [Cancel Output].

3. In the confirmation window, click [OK].

Printing is canceled.

Canceling Printing from the Printer

Procedure

1. Hold down the sub power button for 1 second or longer during printing.

Printing is canceled, and the sub power of the machine switches off automatically. You cannot re-
sume output from the point it was canceled.

2. Press the sub power button to turn the sub power on.

Pausing and Canceling Printing
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Preparing Utility

Start the computer and configure Utility so that you can use it.

Procedure

1. Start the computer on which Utility is installed.

2. Start Utility.

P. 35 Starting Utility

Set the mode of the deodorizer as appropriate for how frequently you print and for the surrounding environ-
ment. We recommend checking the mode of the deodorizer at this point.

P. 26 Deodorizer

MEMO

 RELATED LINKS 

・  P. 24 Composition and Role of Software Used in the Machine

Computer Preparations

Preparations for Printing 63



Step 1: Performing a Nozzle Drop-out Test

Perform a nozzle drop-out test (print a test pattern) and confirm the test pattern before starting printing.
If an error occurs, clean the print heads (normal cleaning). After that, perform the nozzle drop-out test
again.

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/qQr12nDO6Qw

MEMO

Procedure

1. Set up the nozzle drop-out test paper.

2. On the Utility home screen, click [Cleaning].

3. Click [Output] under [Nozzle Drop-out Test].

Printing of the test pattern starts.

4. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing sections in the test pattern indicate "dot drop-out," while a collapsed or sloping test pat-
tern indicates "dot displacement." If the test pattern is difficult to see, open the front cover or
remove the nozzle drop-out test paper, and then change the angle to check the pattern.

• If no dot drop-out or dot displacement occurs: Proceed to the next step.

• If dot drop-out or dot displacement occurs: Proceed to Step 2: Performing Normal Cleaning.

Preparing the Machine
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5. Remove the nozzle drop-out test paper, and then close the front cover.

6. Click [Close] to return to the original screen.

 RELATED LINKS 

・  P. 31 Registering and Setting Up the Nozzle Drop-out Test Paper

・  P. 27 Nozzle Drop-out Test

Preparing the Machine
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Step 2: Performing Normal Cleaning

If dot drop-out or dot displacement was present in step 1, perform normal cleaning.

Procedure

1. Select [Normal Cleaning] under [Head Cleaning], and then click [Execute].

[Cleaning in progress.] and an estimate for the remaining cleaning time are displayed on the Utili-
ty home screen.

2. Set up the nozzle drop-out test paper again.

• If you have removed the nozzle drop-out test paper and checked the test pattern, set up the
printer again.

• If you have checked the test pattern without removing the nozzle drop-out test paper, click
, and then change the [Print Origin] you have specified with [List of Media Settings].

3. Click [Output] under [Nozzle Drop-out Test].

4. When printing is complete, open the front cover.

5. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.

Preparing the Machine

66  Preparations for Printing



• If the problem persists, try performing normal cleaning again.
• If problems such as dot drop-out and dot displacement persist even after you have performed normal clean-

ing several times, use a different cleaning method.

MEMO

If no dot drop-out or dot displacement occurs, preparations for output are finished.

6. Close the front cover.

7. Click [Close] to return to the original screen.

 RELATED LINKS 

・  P. 31 Registering and Setting Up the Nozzle Drop-out Test Paper

・  P. 160 Action Taken When Dot Drop-out or Dot Displacement Occur

Preparing the Machine
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Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/XtlasiJZ5sM

MEMO

Step 1: Creating Printing Data

Decide on the object and the area to be printed to create the print data.

Procedure

1. Decide on the object and the area to be printed.

2. Follow the procedure below to start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

When print data is created using commercially-available application software, the process from data creation
to printing differs.

MEMO

3. Create and save the print data.

See "Introduction to FlexiDESIGNER."

 RELATED LINKS 

・ Introduction to FlexiDESIGNER

・  P. 228 Printing Using Commercially-available Application Software

When Determining the Printing Position Manual-
ly
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Step 2: Placing the Object

Place the object on the flat table.

Procedure

1. Press the sub power button.

2. Open the front cover.

3. Make sure there is no debris or other foreign objects adhered to the flat table.

4. Secure the object to be printed on in place on the flat table.

• Recommendations

Secure the object with an adhesive sheet.

The size of the included adhesive sheet is A5 (210 mm × 148 mm (8.27 in. × 5.83 in.)). It is preferable to
align the adhesive sheet with the white border of the maximum printing area.

MEMO

• Unstable or Otherwise Unwieldy Objects

Use masking tape to secure paper with creases from folding or paper that tends to curl up due
to having been rolled up. If the shape of the object makes it difficult to secure, use a jig.

Masking tape Jig

When Determining the Printing Position Manually
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When the adhesive sheet loses its adhesive strength, rinsing it clean with water will improve
it. If the adhesive sheet does not regain its adhesive strength even after rinsing it clean with
water, replace the adhesive sheet. For information about purchasing adhesive sheets, contact
your authorized dealer or visit our website (https://www.rolanddg.com/).

Protect areas outside of the printing area of thick objects.
Fine particles of ink that are scattered on areas other than the printing area are called "ink mist." Once this
ink mist adheres to the object, it becomes difficult to remove. Cover areas outside the printing area and the
sides of objects with masking tape (A) or use a jig (B).

IMPORTANT

5. If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the object.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

6. Close the front cover.

 RELATED LINKS 

・  P. 21 Considering a Jig
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Step 3: Setting Up the Object

Place the object, and then make it ready for printing.

You can keep the front cover open when you set the height of the flat table, the print origin, or other settings for a
closer view as you work.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. On the Utility home screen, click  [Setup].

2. Register/select the object.

In Utility, "media" is used on the window used to register/manage objects.

MEMO

• When printing on an object for the first time

a. Click .

b. Enter the name of the new object, and then click [OK].

Previously registered media names cannot be used. Enter a new media name.

• We recommend that you set frequently used objects as favorites.

1. Click  next to the name of a registered object to change this icon to .

2. Click  next to the search box.

MEMO

When Determining the Printing Position Manually
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The icon changes to , and the list of media set as favorites appears.

• You can display all registered objects.
If a rotary axis unit is not attached, the normal objects are displayed. If a rotary axis unit is attached,
the objects to be used with this unit are displayed.

Click  or  to display all registered objects.

• For pre-registered objects

Select the object, and then click [OK].

You can use the favorites function and the search function to easily find registered objects.

MEMO

Steps 3 through 5 are not required. Proceed to step 6.

If the height may have changed due to a change in the securing method, suction mat, or similar, set the
height (step 4).

IMPORTANT

3. In the [Object Type] window, select one of the following, and then click [OK].

• Transparent object: Select [Smartphone Cases] or [Others] from the [Transparent] pull-down
menu.

• Opaque object: Select [Opaque].

• [Transparent]: A hand placed on the other side of the object can be seen through it.
• [Opaque]: A hand placed on the other side of the object cannot be seen through it.

See Object (Media) Registration Items for more information on objects.

MEMO

4. Click [Change] next to [Flat Table Height] to set the height of the object.

(1) Click  or  on the right side of the window to align the highest point of the object with

the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the single-
click moving distance.

MEMO
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(2) Click  on the left side of the window to have the highest point of the object approach the

head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from the
head gap sensor without coming into contact with the head gap sensor.

a

(3) If the print surface height is not constant or the object is lifted or is warped, set the [Flat Table
Lowering Amount].

P. 126 Setting a Longer Distance between the Object and the Print Heads

(4) Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

(5) Click [OK].

5. Select [Print Origin] from [Origin Relative] or [Center Relative].

For information about [Print Origin], refer to Object (Media) Registration Items.

6. Click [Change] next to [Print Origin] and [Printing Area], and then set the printable area.

This section explains how to configure settings when the [Origin Relative] is selected. If the dis-
tance from the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]*1) of the maximum printing area is
clear, use [Numeric Input] to enter a numerical value.

When the [Printing Area] setting is finished, the print-head carriage returns to its original position after it has
been left in the same position for approximately 3 minutes to prevent the print heads from drying out. Per-
form the procedure again.

MEMO

(1) Select [Pointer] for [Position Specification].

The print-head carriage moves, and then the pointer on the right side of the print-head car-
riage illuminates the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]) of the maximum printing
area.

(2) Click , , , or , and then move the pointer to specify the print origin (low-

er right of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the for-
ward-backward direction. The position that the pointer illuminates serves as the [Print Ori-
gin].

*1 "S" indicates the scan direction (left/right) and "F" indicates the feed direction (forward/backward).

When Determining the Printing Position Manually
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(3) Click [OK].

Return to the Table Height, Print Origin, and Printing Area settings window.

About [Printing Area]
Since the [Origin Relative] is specified here, the upper left of the [Printing Area] is automatically set to the
maximum position (S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

IMPORTANT

7. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.

When Determining the Printing Position Manually
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Step 4: Perform Printing

Prints from FlexiDESIGNER. When you start FlexiDESIGNER, VersaWorks is also started. VersaWorks should
be left running as it is used to process print data.

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the saved print data.

2. Click .

The [Send to Device] dialog box appears.

3. In [Device], select the output machine (BD-8).

4. Click [Print parameters] and set the printing details.

5. Click [Send].

Printing starts.

If you created the print data using commercially-available application software, it will be printed from VersaWorks. For
more information, see VersaWorks Help.

MEMO

 RELATED LINKS 

・ Introduction to FlexiDESIGNER

・  P. 87 Print Parameters (FlexiDESIGNER)

・ VersaWorks Help
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First, print the alignment markers. After printing the markers, place the object on the flat table, and then
take a picture of it using a smartphone. Import the photo data you have captured into FlexiDESIGNER to
create the print data.

Use this printing method for printing that does not really require a lot of printing positions or printing
sizes, such as when printing with a single point.

• It is not suitable for objects with height.
Since the height of the printed surface cannot be detected, objects with a thickness of 3 mm (0.12 in.) or more will
have a significant printing position misalignment.
This is because the printed surface is in a position closer to the camera than the alignment markers by virtue of its
thickness, and the area of the object is larger by virtue of its proximity. Therefore, printing on thicker objects will
be printed slightly larger.

• It is not suitable for printing all the way to the edges of objects.
Because it is difficult to detect the edges of the object, printing position misalignment may be significant.

IMPORTANT

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/e7o7rG--i_s

MEMO

Step 1: Alignment Marker Printing

Print alignment markers (10 mm × 10 mm [0.39 in. × 0.39 in.]) near the four corners of the maximum
printing area.

Procedure

1. Press the sub power button.

2. Open the front cover.

3. Affix single-color tape to the position shown in the figure on the flat table.

We recommend white tape to reduce printing time for alignment markers.

MEMO

• The affixing area (A) should be at least 12 mm (0.48 in.) from the white line.

Determining the Printing Position Using Cap-
tured Images
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• If the white line of the maximum printing area is transparent, apply the tape over the white
line until it is no longer transparent or use non-transparent tape.

AA

A

4. Close the front cover.

5. Set up the tape pasted in step 3 in the maximum printing area.

Specify the print origin as S: 0 mm (0 in.), F: 0 mm (0 in.) in [Origin Relative]. If you do not speci-
fy the printing area, it will be set to W: 210 mm (8.27 in.), L: 148 mm (5.83 in.).

6. On the Utility home screen, click .

7. Click [Preferences], and then click [Execute] for [Alignment Marker Printing].

8. If the tape in step 3 is white-colored, clear the [Print White Alignment Marker Background] check box.

9. Click [OK].

Printing starts.

10. When printing is finished, click [Close].

11. Click [Cancel Setup].

12. Click [OK].

 RELATED LINKS 

・  P. 18 Printable Area
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Step 2: Placing and Imaging the Object

Procedure

1. Open the front cover.

2. Place the object within the printing area on the flat table (inside the white line).

(1) Place the object.

You cannot use the included adhesive sheet because it hides the alignment markers. Cut be-
fore use, or fix the object so that it will not shift.

(2) If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the ob-
ject.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

3. Keep the following points in mind when performing imaging with a smartphone.

• Focus on the alignment marker.

Perform imaging by focusing on the alignment markers, not the object.

• All the alignment markers in the four corners should be included in the captured image.

If the alignment markers are hidden or missing, the position cannot be detected. Perform
imaging so that all four alignment markers are included in the captured image.

Example of good po-
sitioning

Example of poor po-
sitioning

 
 

• Perform imaging from directly above the object.

Determining the Printing Position Using Captured Images
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Perform imaging as shown in the following figure so that the edges of the object can be de-
tected more easily. Perform imaging so that the sides of the object are not captured, especial-
ly for thicker objects.

Good

No
Good

• Save imaging data in jpeg or HEIC format.

If you are using a model that does not support the .jpeg or .HEIC photo data format,*1 change
the save format to jpeg or HEIC, or convert the data to jpeg or HEIC before importing.

4. Save the imaging data to your computer.

 RELATED LINKS 

・  P. 212 Printing Position Using Alignment Markers Is Misaligned

・  P. 214 Alignment Markers Cannot Be Read

*1 Some Apple products have a default save format of HEIC.
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Step 3: Setting Up the Object

Place the object, and then make it ready for printing.

You can set the flat table height while keeping a close eye on it by working with the front cover open.
However, clicking [OK] in these settings may cause the flat table to start moving. Therefore, when the front cover is
open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. On the Utility home screen, click  [Setup].

2. Register/select the object.

In Utility, "media" is used on the window used to register/manage objects.

MEMO

• When printing on an object for the first time

a. Click .

b. Enter the name of the new object, and then click [OK].

Previously registered media names cannot be used. Enter a new media name.

• We recommend that you set frequently used objects as favorites.

1. Click  next to the name of a registered object to change this icon to .

2. Click  next to the search box.

MEMO
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The icon changes to , and the list of media set as favorites appears.

• You can display all registered objects.
If a rotary axis unit is not attached, the normal objects are displayed. If a rotary axis unit is attached,
the objects to be used with this unit are displayed.

Click  or  to display all registered objects.

• For pre-registered objects

Select the object, and then click [OK].

You can use the favorites function and the search function to easily find registered objects.

MEMO

Steps 3 and 4 are not required. Proceed to step 5.

If the height may have changed due to a change in the suction mat or similar, set the height (step 4).

IMPORTANT

3. In the [Object Type] window, select one of the following, and then click [OK].

• Transparent object: Select [Smartphone Cases] or [Others] from the [Transparent] pull-down
menu.

• Opaque object: Select [Opaque].

• [Transparent]: A hand placed on the other side of the object can be seen through it.
• [Opaque]: A hand placed on the other side of the object cannot be seen through it.

See Object (Media) Registration Items for more information on objects.

MEMO

4. Click [Change] next to [Flat Table Height] to set the height of the object.

(1) Click  or  on the right side of the window to align the highest point of the object with

the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the single-
click moving distance.

MEMO
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(2) Click  on the left side of the window to have the highest point of the object approach the

head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from the
head gap sensor without coming into contact with the head gap sensor.

a

(3) If the print surface height is not constant or the object is lifted or is warped, see below to set the
[Flat Table Lowering Amount].

P. 126 Setting a Longer Distance between the Object and the Print Heads

(4) Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

(5) Click [OK].

5. Click [OK].

If the [Printing Area] is not set, the maximum printing area (W: 210 mm × L: 148 mm [W: 8.26 in.
× L: 5.82 in.]) becomes the [Printing Area] by default. If you are printing using alignment markers,
set to the maximum printing area.

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered media name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.

Determining the Printing Position Using Captured Images
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Step 4: Creating Data while Checking the Position

Procedure

1. Follow the procedure below to start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

2. Follow the procedure below to import the photo file saved in Step 1: Alignment Marker Printing into
FlexiDESIGNER.

(1) Click [File]>[Open AR Photo].

The file selection window opens.

(2) Select the photographed image file, and then click [Import...].

The captured image is cropped to the size of the four alignment markers (210 mm × 148 mm
[8.27 in. × 5.83 in.]) and is displayed in the design area.

Determining the Printing Position Using Captured Images
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If the alignment markers cannot be read, [Conversion failed the original image will be used.] is dis-
played. Refer to Alignment Markers Cannot Be Read to perform imaging again and reading again.

MEMO

3. Create and save the print data.

Print data is created with the object in the background, so you can work while visualizing how it
will look after printing.

See "Introduction to FlexiDESIGNER" for information on creating print data.

 RELATED LINKS 

・ Introduction to FlexiDESIGNER

・  P. 212 Printing Position Using Alignment Markers Is Misaligned
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Step 5: Perform Printing

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the saved print data.

2. Click .

The [Send to Device] dialog box appears.

3. Check the following.

• [Device]: BD-8

• [Number of prints]: 1

• [Output]: Page

4. Click [Print parameters] and set the printing details.

Set [Media Type] and [Mode] on the [Quality] tab. Set as appropriate depending on whether Pr or
Wh is used and on the print data.

5. Click [Send].

Printing starts.

6. Once printing is complete, remove the object, and exit out of setup in Utility.

 RELATED LINKS 

・ Introduction to FlexiDESIGNER

・  P. 87 Print Parameters (FlexiDESIGNER)
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Selecting different options for the [Media Type] and [Mode] print parameters allows for different types of
printing. These different types are listed below.

[Media Type] [Quality] [Mode] Description

[General] [High Speed]
[Standard]
[High Quality]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

This is used for general objects or an object
that has a smooth print surface.

[Text Decoration] [High Speed]
[Standard]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

Suitable for simple printing, such as initials or
shapes in a single point, or printing on a small
area.

[Generic Distance] [High Speed]
[Standard]

[CMYK]
[White->CMYK]
[CMYK->White]
[White]

Used for objects with a print surface that is 2
mm (0.08 in.) or more uneven or spherical in
shape.
Printing time is longer compared to [General].

[Generic with Primer] [High Speed]
[Standard]
[High Quality]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

Used for printing primer under [General].

[Text Decoration with Primer] [High Speed]
[Standard]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

Used for printing primer under [Text Decora-
tion].

[Generic Distance with Pri-
mer]

[High Speed]
[Standard]

[Primer->CMYK]
[Primer->White->CMYK]
[Primer->CMYK->White]
[Primer->White]

Used for printing primer under [Generic Dis-
tance].
Printing time is longer compared to [Generic
with Primer].

Examples of [Media Type] and [Mode] selection

When Printing CMYK on Wh
Select [General] and [Wh->CMYK], and select the [White Plate Generation] check box.

←Wh
←CMYK

When Printing Wh on CMYK
Select [General] and [CMYK->Wh], and select the [White Plate Generation] check box.

←Wh
←CMYK

When Printing CMYK on Pr
Select [Generic with Primer] and [Pr->CMYK].

←Pr
←CMYK

When Printing Wh and CMYK on Pr
Select [Generic with Primer] and [Pr->Wh->CMYK], and select the [White Plate Generation]
check box. ←Wh

←Pr

←CMYK

When Printing CMYK and Wh on Pr
Select [Generic with Primer] and [Pr->CMYK->Wh], and select the [White Plate Generation]
check box.

←Wh

←Pr
←CMYK
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Print text on a powder foundation case.

Step 1: Creating Printing Data

Measure the printing size of the object, set the printing area, and then create print data.

Follow the procedure below to operate FlexiDESIGNER Ver. 22.0.0, build number 4176. Operation methods may vary de-
pending on the version of FlexiDESIGNER.

MEMO

Procedure

1. Measure the printing area (print surface of the object).

This is necessary to set the printing area. Make a note of the measurement when you take it. The
print surface of the powder foundation case to be printed in this case is 111 mm (4.37 in.) wide,
and 71 mm (2.79 in.) long.

2. Follow the procedure below to start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

3. Follow the procedure below to set the size of the printing data.

(1) Click the  icon (A).

The [DesignCentral] dialog box (B) opens.

(2) On the  tab (C), click the pull-down menu [▼], and then select [Custom].

(3) Enter the printing size (111 mm, 71 mm [4.37 in., 2.79 in.]) measured in step 1.

Printing on Cosmetic Items
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A printing size frame (D) is created in the design area.

4. Create data for printing.

Enter a name here, and apply a color to the text.

(1) Click [Text Tool].

(2) Click a location close to where you want to enter the text, and then enter the text.

(3) Click [Select Tool].

(4) Select the text you entered, and then click the  tab in the [DesignCentral] dialog box to adjust

the font and size.

(5) Select the text, and then place them in the desired position.

(6) Click the  icon.

The [Fill/Stroke Editor] dialog box opens.

(7) With the text selected, click the pull-down menu [▼] in the  tab, and then select [Silid fill].

(8) Select the desired color from the color selection pull-down menu [▼].

5. Click [File]>[Save] to save the data.

 RELATED LINKS 
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・ Introduction to FlexiDESIGNER
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Step 2: Placing and Setting Up the Object

Place the object, and then make it ready for printing.

You can keep the front cover open when you set the height of the flat table, the print origin, or other settings for a
closer view as you work.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Start Utility.

P. 35 Starting Utility

2. Place the object.

(1) If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the ob-
ject.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

• Protect the areas other than the printing area with masking tape.

(2) Open the front cover.

(3) Make sure there is no debris or other foreign objects adhered to the flat table.

(4) Place an adhesive sheet on the flat table.

(5) Place the object.

• Print data is printed with the data rotated 180 degrees.

• Place the object inside the white border and parallel to the white border.

(6) Close the front cover.

3. Set up the object.

(1) On the Utility home screen, click  [Setup].

(2) Click .

In Utility, "media" is used on the window used to register/manage objects.

MEMO

Previously registered media names cannot be used. Enter a new media name.

Printing on Cosmetic Items
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(3) Enter the name of the object, and then click [OK].

(4) Select [Opaque] on the [Object Type] window, and then click [OK].

(5) Click [Change] next to [Flat Table Height] to set the height of the object.

i. Click  or  on the right side of the window to align the highest point of the

object with the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the
single-click moving distance.

MEMO

ii. Click  on the left side of the window to have the highest point of the object ap-

proach the head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from
the head gap sensor without coming into contact with the head gap sensor.

a

iii. Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

iv. Click [OK].

(6) Click [Change] for [Print Origin] and [Printing Area], then click [Print Origin].

When the [Printing Area] setting is finished, the print-head carriage returns to its original position after
it has been left in the same position for approximately 3 minutes to prevent the print heads from drying
out. Perform the procedure again.

MEMO

i. Select [Pointer] for [Position Specification].

The print-head carriage moves, and then the pointer on the right side of the print-head
carriage illuminates the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]) of the maximum
printing area.

ii. Click , , , or , and then move the pointer to specify the print ori-

gin (lower right of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the
forward-backward direction. The position that the pointer illuminates serves as the [Print
Origin].
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iii. Click [OK].

Returns to the [Flat Table Height], [Print Origin], and [Printing Area] settings window.

About [Printing Area]
Since the [Origin Relative] is specified here, the upper left of the printing area is automatically set to
the maximum position (S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

MEMO

4. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.
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Step 3: Perform Printing

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the printing data created in FlexiDESIGNER.

Click [File]>[Open] to open the saved printing data.

2. Click .

The [Send to Device] dialog box opens.

3. Check the following.

• [Device]: BD-8

• [Number of prints]: 1

• [Output]:[Page]

4. Click [Print parameters].

5. In the [Quality] tab, select the following.

• [Media Type]:[Text Decoration]

• [Print Quality]:[Standard]

• [Mode]: [CMYK (v)]

6. Click [OK].

The Print Parameters window closes.

7. Click [Send].

Printing starts.

8. Once printing is complete, remove the object, and exit out of setup in Utility.

 RELATED LINKS 

・  P. 87 Print Parameters (FlexiDESIGNER)
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Print text and shapes on golf balls.

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/_MlXm7sClU0

MEMO

Step 1: Creating Printing Data

Set the printing size, and then create the print data.

Follow the procedure below to operate FlexiDESIGNER Ver. 22.0.4, build number 4398. Operation methods may vary de-
pending on the version of FlexiDESIGNER.

MEMO

Procedure

1. Follow the procedure below to start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

2. Follow the procedure below to set the size of the printing data.

(1) Click the  icon (A).

The [DesignCentral] dialog box (B) opens.

(2) On the  tab (C), click the pull-down menu [▼], and then select [Custom].

Printing on Golf Balls
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(3) Enter the printing size for golf balls.

For printing on golf balls, set the [Media Type] as follows as appropriate for the printing area.

• [General]: Printing area up to 18 mm (0.7 in.) in diameter
• [Generic Distance]: Printing area from 18 mm to 29 mm (0.71 in. to 1.14 in.) in diameter

IMPORTANT

A printing size frame (D) is created in the design area.

3. Create data for printing.

In this section, you design the message and the shapes. Specify the fonts and angles of text, the
sizes of shapes, and other parameters.

(1) Click [Text Tool].

(2) Click a location close to where you want to enter the text, and then enter the text.

(3) Click [Select Tool], and select the text entry.

(4) Click the  tab in the [DesignCentral] dialog box, and then adjust the font and size.

(5) Select the text, and then place them in the desired position.

(6) Click the  tab to adjust the angle.

(7) Click the  icon.

(8) With the text selected, click the pull-down menu in the  tab, and then select [Silid fill].

(9) Select any color from the pull-down menu.

(10) Hold down [Rectangle Tool], and then select [Starburst Tool].

(11) Drag near the location where you want to add the shape.

A star shape will be drawn corresponding to the length of the drag.

(12) With the shape selected, click the pull-down menu in the  tab, and then select [Silid fill].

(13) Select any color from the pull-down menu.

(14) Repeat steps (11) through (13), and then place the shapes.
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4. Click [File]>[Save] to save the data.

 RELATED LINKS 

・ Introduction to FlexiDESIGNER
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Step 2: Placing and Setting Up the Object

Place the object, and then make it ready for printing.

You can keep the front cover open when you set the height of the flat table, the print origin, or other settings for a
closer view as you work.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Start Utility.

P. 35 Starting Utility

2. Prepare a jig that ensures a printing area of about 30 mm × 30 mm (1.18 in. × 1.18 in.).

A

B

C

A: Approx. 30 mm (1.18 in.) B: Approx. 40 mm (1.57 in.) C: Approx. 100 mm (3.94 in.)

3. Place the object.

(1) If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the ob-
ject.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

(2) Open the front cover.

(3) Make sure there is no debris or other foreign objects adhered to the flat table.

(4) Place an adhesive sheet on the flat table.

(5) Place the object and attach the jig.

• Print data is printed with the data rotated 180 degrees.

• Jigs made from light material such as paper should also themselves be secured.

(6) Close the front cover.

4. Set up the object.

(1) On the Utility home screen, click  [Setup].

(2) Click .
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In Utility, "media" is used on the window used to register/manage objects.

MEMO

(3) Enter the name of the object, and then click [OK].

Previously registered media names cannot be used. Enter a new media name.

(4) Select [Opaque] on the [Object Type] window, and then click [OK].

(5) Click [Change] next to [Flat Table Height] to set the height of the object.

i. Click  or  on the right side of the window to align the highest point of the

object with the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the
single-click moving distance.

MEMO

ii. Click  on the left side of the window to have the highest point of the object ap-

proach the head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from
the head gap sensor without coming into contact with the head gap sensor.

a

iii. Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

iv. Click [OK].

(6) Select [Center Relative] in [Print Origin], click [Change], and then set the printable area.
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When the [Printing Area] setting is finished, the print-head carriage returns to its original position after
it has been left in the same position for approximately 3 minutes to prevent the print heads from drying
out. Perform the procedure again.

MEMO

Specify the [Printing Area] with the node of the golf ball as the [Print Origin].

i. Select [Pointer] for [Position Specification].

The print-head carriage and the flat table move, and then the pointer on the right side of
the print-head carriage illuminates the center of the maximum printing area.

ii. Select [Printing Area].

The print-head carriage and the flat table move, and then the pointer illuminates the up-
per left of the maximum printing area.

iii. Click , , , or , and then move the pointer to change the [Printing

Area] to the print data size.

• The print-head carriage moves in the left-right direction and the flat table moves in
the forward-backward direction.

• If you narrow the printing area, you will be able to move the center position.

iv. Select [Center Position].

v. Click , , , or , and then move the pointer to specify the node of

the golf ball (the center of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the
forward-backward direction. The position that the pointer illuminates serves as the cen-
ter of the printing area.

vi. Make sure that the width and length of the [Printing Area] are the same as the print data
size.

vii. Click [OK].

Returns to the [Flat Table Height], [Print Origin], and [Printing Area] settings window.

5. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.
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Step 3: Perform Printing

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the printing data created in FlexiDESIGNER.

Click [File]>[Open] to open the saved printing data.

2. Click .

The [Send to Device] dialog box opens.

3. Check the following.

• [Device]: BD-8

• [Number of prints]: 1

• [Output]:[Page]

4. Click [Print parameters].

5. In the [Quality] tab, select the following.

• [Media Type]: [General] or [Generic Distance]*1

• [Print Quality]:[Standard]

• [Mode]: [CMYK (v)]

• [Layout]: [Center on the Media]

6. Click [OK].

The Print Parameters window closes.

7. Click [Send].

Printing starts.

8. Once printing is complete, remove the object, and exit out of setup in Utility.

 RELATED LINKS 

・  P. 87 Print Parameters (FlexiDESIGNER)

*1 Select [General] if the print data is less than 18 mm (0.70 in.) in diameter. Select [Generic Distance] if the print data is 18 mm
(0.70 in.) or more in diameter.
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Print photos you have taken with your smartphone on a smartphone case.

• In this procedure, an opaque smartphone case is oriented horizontally and is printed on. However, when printing on
a transparent smartphone case, carry out work while referring to Printing on Transparent Smartphone Cases
to prevent UV light reflected off the inside of the object from striking the print head surface.

• Use the following link to view a reference video for this procedure. We recommend that you view this video to un-
derstand the overall flow of work.

https://youtu.be/731hOx8RR0A

MEMO

Step 1: Creating Printing Data

Measure the printing size of the object, set the printing area, and then create print data.

Follow the procedure below to operate FlexiDESIGNER Ver. 22.0.0, build number 4176. Operation methods may vary de-
pending on the version of FlexiDESIGNER.

MEMO

Procedure

1. Measure the printing area (print surface of the object).

This is necessary to set the printing area. Make a note of the measurement when you take it. The
printed surface of smartphone cases is 134 mm (5.28 in.) wide and 67 mm (2.64 in.) long when
placed horizontally. This time, to print on the entire surface of the case, set the printing area to
be larger than the printed surface. Any printing outside of the edges of the printed surface will be
wasted, but you can print all the way up to the edges.

2. Start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].
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(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

3. Set the printing area according to the procedure below.

(1) Click the  icon (A).

The [DesignCentral] dialog box (B) opens.

(2) On the  tab (C), click the pull-down menu [▼], and then select [Custom].

(3) Enter a printing area (136 mm × 69 mm (5.35 in. × 2.72 in.) that is 1 mm (0.04 in.) larger than the
printing area measured in step 1 in all four directions, from both front to back and left to right.

A printing area frame (D) is created in the design area.

4. Create data for printing.

Here, the photos are imported, sized, and trimmed. A primer plate is then created to improve ad-
hesion and a white plate is created to prevent the color of the printed object from showing
through.

(1) Save the photo data to your computer.

(2) Click [File]>[Import...], select the saved photo data, and then click [Import...].

The blue dashed frame of the photo data size is displayed in the window.

(3) Click the desired location, and then paste the photo data into the design area.

If the photo data size is large, use [Zoom Out] or "Ctrl + Scroll" to view the entire photo data.

IMPORTANT

(4) Select the photo data, and then adjust the size.

i. Select the loaded photo data.

ii. In the [DesignCentral] dialog box, select the  tab and click .

The loaded photo will rotate 90° counterclockwise.

iii. In the [DesignCentral] dialog box, select the [Proportional] check box.

iv. Enter a size close to that of the printing area and then press Enter.

Adjust the size based on the size of the image to be trimmed. Here, set a width of 145
mm (5.71 in.) for the printing area (136 mm, 69 mm [5.35 in., 2.72 in.]).
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(5) Perform trimming.

i. Select [Rectangle Tool], and create a frame for the printing area (136 mm × 69 mm

[5.35 in. × 2.72 in.]).

Since this frame will be used as an outer frame for trimming, click  and then config-

ure the settings as follows.

•  tab:[No fill]

•  tab: Type of line: Solid line; Line color: Red

ii. Select the [Select Tool], and then move the frame to determine the position to be

trimmed.

iii. With the image and frame selected with the selection tool, click [Ar-
range]>[Mask]>[Mask].

The image is trimmed with a red line.

(6) With the image and frame selected, click [Arrange]>[Align]>[Both Centers to Page].

The selected image is placed in the center of the printing area.

5. Click [File]>[Save] to save the data.
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Step 2: Placing and Setting Up the Object

Place the object, and then make it ready for printing.

You can keep the front cover open when you set the height of the flat table, the print origin, or other settings for a
closer view as you work.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Start Utility.

P. 35 Starting Utility

2. Place the object.

(1) If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the ob-
ject.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

• Protect the areas other than the printing area with masking tape.

In this case, the printing area is set wider than the object in order to print to the edges of
the object. Protect the sides of the object and the hole in the printing area from being ex-
posed to ink mist.

(2) Open the front cover.

(3) Make sure there is no debris or other foreign objects adhered to the flat table.

(4) Place an adhesive sheet on the flat table.

(5) Place the object.

• Print data is printed with the data rotated 180 degrees.

• Place the object inside the white border and parallel to the white border.

(6) Close the front cover.

3. Set up the object.

In Utility, "media" is used on the window used to register/manage objects.

MEMO

(1) On the Utility home screen, click  [Setup].

(2) Click .
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(3) Enter the name of the object, and then click [OK].

Previously registered media names cannot be used. Enter a new media name.

(4) Select [Opaque] on the [Object Type] window, and then click [OK].

If the object is transparent, select [Smartphone Cases] from the [Transparent] pull-down menu.

MEMO

(5) Click [Change] next to [Flat Table Height] to set the height of the object.

i. Click  or  on the right side of the window to align the highest point of the

object with the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the
single-click moving distance.

MEMO

ii. Click  on the left side of the window to have the highest point of the object ap-

proach the head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from
the head gap sensor without coming into contact with the head gap sensor.

a

iii. Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

iv. Click [OK].

(6) Click [Change] for [Print Origin] and [Printing Area], then click [Print Origin].
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When the [Printing Area] setting is finished, the print-head carriage returns to its original position after
it has been left in the same position for approximately 3 minutes to prevent the print heads from drying
out. Perform the procedure again.

MEMO

i. Select [Pointer] for [Position Specification].

The print-head carriage moves, and then the pointer on the right side of the print-head
carriage illuminates the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]) of the maximum
printing area.

ii. Click , , , or , and then move the pointer to specify the print ori-

gin (lower right of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the
forward-backward direction. The position that the pointer illuminates serves as the print
origin.

Since the print data this time will be larger than the printing area by 1 mm (0.04 in.) in
each direction, specify a print origin outside the printing area where "a" in the figure be-
low is 1 mm (0.04 in.).

a

a

iii. Click [OK].

Returns to the [Flat Table Height], [Print Origin], and [Printing Area] settings window.

Printing area
Since the [Origin Relative] is specified here, the upper left of the printing area is automatically set to
the maximum position (S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

MEMO

4. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.
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Step 3: Perform Printing

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the printing data created in FlexiDESIGNER.

Click [File]>[Open] to open the saved printing data.

2. Click .

The [Send to Device] dialog box opens.

3. Check the following.

• [Device]: BD-8

• [Number of prints]: 1

• [Output]:[Page]

4. Click [Print parameters].

5. In the [Quality] tab, select the following.

• [Media Type]:[General]

• [Print Quality]:[High Quality]

• [Mode]: [White->CMYK (v)]

• [Special Color Plate Generation]

• [White Plate Generation]: Select the check box.

• [Generated Pattern]:[Print Area]

• [Size Correction]:[No]

6. Click [OK].

The Print Parameters window closes.

7. Click [Send].

Printing starts.

8. Once printing is complete, remove the object, and exit out of setup in Utility.

 RELATED LINKS 

・  P. 87 Print Parameters (FlexiDESIGNER)
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Print photos and text in reverse from the back of a transparent acrylic shield. White is printed behind the
photo and text to properly express colors of the print data.

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/ud6ygZ9zvbc

MEMO

Step 1: Creating Printing Data

Measure the printing size of the object, set the printing area, and then create print data.

Follow the procedure below to operate FlexiDESIGNER Ver. 22.0.0, build number 4176. Operation methods may vary de-
pending on the version of FlexiDESIGNER.

MEMO

Procedure

1. Measure the printing area (print surface of the object).

This is necessary to set the printing area. Make a note of the measurement when you take it. The
printing area of the acrylic stand is 130 mm (5.12 in.) wide and 90 mm (3.54 in.) long when placed
horizontally. Put the cropped photo and message in this printing era, mirror it, and then print it.

2. Start FlexiDESIGNER.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for FlexiDESIGNER.

Printing on an Acrylic Stand
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3. Set the printing area according to the procedure below.

(1) Click the  icon (A).

The [DesignCentral] dialog box (B) opens.

(2) On the  tab (C), click the pull-down menu [▼], and then select [Custom].

(3) Enter the printing area (130 mm × 90 mm [5.12 in. × 3.54 in.]).

A printing area frame (D) is created in the design area.

4. Create data for printing.

Here, the photos are imported, sized, and trimmed. The message is then added, the photo and
text are mirrored, and then a white plate is created to prevent the colors of the printed object
from showing through.

(1) Save the photo data to your computer.

(2) Click [File]>[Import...], select the saved photo data, and then click [Import...].

The blue dashed frame of the photo data size is displayed in the window.

(3) Click the desired location, and then paste the photo data into the design area.

If the photo data size is large, use [Zoom Out] or "Ctrl + Scroll" or other means to view the entire

photo data.

MEMO

(4) Select the photo data, and then adjust the size.

i. Select the loaded photo data.

ii. In the [DesignCentral] dialog box, select the [Proportional] check box.

iii. Enter a size close to that of the printing area and then press Enter.

Adjust the size based on the size of the image to be trimmed. Here, set a width of 150
mm (5.90 in.) for the printing area (130 mm × 90 mm [5.12 in., 3.54 in.]).
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(5) Perform trimming.

i. Hold down [Rectangle Tool], and then select [Oval Tool].

Since this frame will be used as an outer frame for trimming, click  and then config-

ure the settings as follows.

•  tab:[No fill]

•  tab: Type of line: Solid line; Line color: Red

ii. Select the [Select Tool], and then move the frame to determine the position to be

trimmed.

iii. With the image and frame selected with the selection tool, click [Ar-
range]>[Mask]>[Mask].

The image is trimmed with a red line.

iv. Use the [Select Tool] to move the photo to the frame of the printing area and check that
there are no problems with the size.

Zoom in/out using the [DesignCentral] dialog box or the interface item around the select-
ed photo.

(6) Place the message.

i. Select the [Text Tool].

ii. Click a location close to where you want to enter the text, and then enter the text.

iii. Click [Select Tool], and select the text entry.

iv. Click the  tab in the [DesignCentral] dialog box, and then adjust the font and size.

v. Use [Select Tool] and select the message, then click [Arrange]>[Convert to Out-

lines].

The message text are converted to the state of shapes (they do not change in appear-
ance) so they can be mirrored.

vi. Change the color and lines of the [Fill/Stroke Editor] dialog box.

(7) Mirror the photo and message.

i. Select the photo and message in the [Select Tool].

ii. Click [Arrange]>[MIrror...], and then press Enter.
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The photo will be inverted, centered on the right side.

(8) With the image and message selected, click [Arrange]>[Align]>[Vertical Center to Page].

The selected photo and message will be placed in the vertical center of the printing area.

5. Click [File]>[Save] to save the data.
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Step 2: Placing and Setting Up the Object

Place the object, and then make it ready for printing.

You can keep the front cover open when you set the height of the flat table, the print origin, or other settings for a
closer view as you work.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Start Utility.

P. 35 Starting Utility

2. Place the object.

(1) If necessary, perform the following operations.

• Use a static removal brush or anti-static cloth to eliminate static electricity from the ob-
ject.

• Degrease the printing area of the object using anhydrous ethanol or isopropyl alcohol.

• Protect the areas other than the printing area with masking tape.

(2) Open the front cover.

(3) Make sure there is no debris or other foreign objects adhered to the flat table.

(4) Place an adhesive sheet on the flat table.

(5) Place the object.

• Print data is printed with the data rotated 180 degrees.

• Place the object inside the white border and parallel to the white border.

(6) Close the front cover.

3. Set up the object.

In Utility, "media" is used on the window used to register/manage objects.

MEMO

(1) On the Utility home screen, click  [Setup].

(2) Click .

(3) Enter the name of the object, and then click [OK].
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Previously registered media names cannot be used. Enter a new media name.

(4) Select [Others] from the [Transparent] pull-down menu and click [OK].

(5) Click [Change] next to [Flat Table Height] to set the height of the object.

i. Click  or  on the right side of the window to align the highest point of the

object with the forward-back position of the head gap sensor.

You can select 0.1 mm (0.004 in.), 1 mm (0.04 in.), 10 mm (0.39 in.), or 50 mm (1.97 in.) as the
single-click moving distance.

MEMO

ii. Click  on the left side of the window to have the highest point of the object ap-

proach the head gap sensor.

Move the highest printing position of the object up to a position (a) a few mm away from
the head gap sensor without coming into contact with the head gap sensor.

a

iii. Click [Automatic Setup].

The flat table moves and the head gap sensor detects the height of the object.

iv. Click [OK].

(6) Click [Change] for [Print Origin] and [Printing Area], then click [Print Origin].

When the [Printing Area] setting is finished, the print-head carriage returns to its original position after
it has been left in the same position for approximately 3 minutes to prevent the print heads from drying
out. Perform the procedure again.

MEMO

i. Select [Pointer] for [Position Specification].

The print-head carriage moves, and then the pointer on the right side of the print-head
carriage illuminates the lower right (S: 0 mm [0 in.], F: 0 mm [0 in.]) of the maximum
printing area.

ii. Click , , , or , and then move the pointer to specify the print ori-

gin (lower right of the printing area).

The print-head carriage moves in the left-right direction and the flat table moves in the
forward-backward direction. The position that the pointer illuminates serves as the [Print
Origin].
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iii. Click [OK].

Returns to the [Flat Table Height], [Print Origin], and [Printing Area] settings window.

About [Printing Area]
Since the [Origin Relative] is specified here, the upper left of the printing area is automatically set to
the maximum position (S: 210 mm [8.26 in.], F: 148 mm [5.82 in.]).

MEMO

4. Click [OK].

[Setup in progress.] is displayed. When setup is completed, you are returned to the home screen,
and the registered object name, and the set [Flat Table Height], [Print Origin], and [Printing
Area] are displayed.
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Step 3: Perform Printing

Depending on the computer display settings, the [Send to Device] or [Print parameters] window may not fit on the
monitor. If this occurs, adjust the magnification and layout in the display settings.

MEMO

Procedure

1. Open the printing data created in FlexiDESIGNER.

Click [File]>[Open] to open the saved printing data.

2. Click .

The [Send to Device] dialog box opens.

3. Check the following.

• [Device]: BD-8

• [Number of prints]: 1

• [Output]:[Page]

4. Click [Print parameters].

5. In the [Quality] tab, select the following.

• [Media Type]:[General]

• [Print Quality]:[High Quality]

• [Mode]: [CMYK->White]

• [Special Color Plate Generation]

• [White Plate Generation]: Select the check box.

• [Generated Pattern]:[Print Area]

• [Size Correction]:[No]

6. Click [OK].

The Print Parameters window closes.

7. Click [Send].

Printing starts.

8. Once printing is complete, remove the object, and exit out of setup in Utility.

 RELATED LINKS 

・  P. 87 Print Parameters (FlexiDESIGNER)
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Minimizing Print-head Carriage Movement

This shortens printing time by narrowing the print-head carriage movement to the width of the print data.
This feature is effective when the print area or print data has a small width.

Because the default setting is [Output Data Width], there is no effect if this setting is not changed.

Procedure

1. Set up the object.

P. 72 Setting Up the Object

2. On the Utility home screen, click .

3. Click the [List of Media Settings]>[Printing Movement Range] pull-down menu.

4. Select [Output Data Width].

The following three settings are available for [Printing Movement Range]. This setting affects
printing time and print quality, and should be set as appropriate for the situation.

Settings Features

[Output Data Width] Matches the range of print-head carriage movement to the printing data. Movement is lim-
ited to the minimum amount necessary, and this can be expected to yield the fastest print-
ing. When this feature is used, the time needed for the ink to harden is not constant, and
an uneven color may result.

[Media Width] Matches the print-head carriage movement range to the set printing area.

[Full Width] The print-head carriage moves from one end of the machine to the other. This setting
makes the speed of print-head carriage movement constant at all times and produces the
most stable printing results.

5. Click [Apply] to confirm your entry.

6. Click [Close] to return to the original screen.

• Default setting: [Output Data Width]

MEMO
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In the following cases, settings related to the flat table height need to be configured.

• Printing in layers (i.e., the printing surface gradually becomes higher).

• The height of the object changes during printing due to lifting up or warping of the printed object.

• Mass-producing an object whose height varies due to differences among individual objects without
changing the height of the registered media.

There are two height settings for the flat table.

• [Readjust]

The height of the flat table is readjusted when the print heads come into contact with the object dur-
ing printing.

P. 123 Readjusting Height during Printing

• [Flat Table Lowering Amount]

Printing is performed by lowering the flat table in advance below the specified value.
P. 126 Setting a Longer Distance between the Object and the Print Heads
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Readjusting Height during Printing

This setting allows the height to be readjusted to continue printing even when the object comes into con-
tact with the head gap sensor in the following cases.

• When the object becomes loose or warps during printing

• When the print surface is raised due to printing on stacked objects

This function is effective when using objects that cannot be reprinted on.

However, this setting has the following disadvantages.

• Printing time is longer because of the time required for readjustment.

• The print surface comes into contact with the head gap sensor.

Therefore, [Readjust] should be used for printing for which you want to ensure image quality even if it
takes longer or printing that cannot be redone.

• When the height is readjusted automatically and printing continues, the height setting is changed. Therefore, the
print quality may be changed. Hence, proper printing requires that the object to be printed on be secured properly
before printing to keep it from moving out of position or lifting up.

• Select [Readjust] to automatically adjust the height when the head gap sensor touches the object.
• Even if [Readjust] is selected, printing and setup will be canceled in the following cases.

• When the height reaches the [Maximum Value (Threshold)] of automatic adjustment
• When the object to be printed on comes into contact with the head gap sensor during automatic readjustment,

even if the flat table has moved to the bottom
• If this function is not used ([Operation on Height Error Detection]:[Stop]), printing is stopped when a height error

is detected during printing, and [Flat Table Height Error] is displayed.

MEMO

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Select [Readjust] for [Operation on Height Error Detection] under [Clearance Settings].

4. Click [▲][▼] next to [Maximum Value (Threshold)] to set the maximum amount by which the flat table is
lowered when a height error is detected.

The height adjustment is made gradually until the object no longer touches the head gap sensor.
Set this in anticipation of height variations, such as when there are changes in the height of the
object.

The greater the distance between the print surface and the print heads, the lower the print quality tends to
be. It is preferable to make smaller adjustments. Keep the following points in mind when determining the
[Maximum Value (Threshold)].

• Consider the effect on the printing image quality in order to obtain satisfactory image quality.
• The variation in height across the entire print surface (not the print target area but including parts that

will not be printed)

MEMO

5. Click [Apply] to confirm your entry.

6. Click [Close] to return to the original screen.
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• Default settings

• [Operation on Height Error Detection]:[Stop]
• [Maximum Value (Threshold)] when [Readjust] is selected: 10 mm (0.39 in.)

MEMO
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Reflecting the Readjusted Flat Table Height in the Media Settings Values

This section explains how to reflect the flat table height for which [Readjust] has been performed in the
media settings. You can overwrite the height of the flat table for registered media.

When printing on the same object, the registered media settings values are used. You can turn on this set-
ting to reduce the time for [Readjust] if the height of the object varies or if the height of the object
changes due to layered printing.

Print time is reduced, but print quality tends to be lower because the distance between the print heads
and the object is lengthened. If print quality is important to you regardless of whether it takes more time
to print, you should turn off this setting.

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Select the [Maintain Height after Readjustment] check box for [Clearance Settings] - [Operation on
Height Error Detection].

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

• Default settings

• [Maintain Height after Readjustment]: Cleared

MEMO
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Setting a Longer Distance between the Object and the Print Heads

When the object is set up, the distance between the print heads and the object is set at 1.0 mm (0.04
in.). However, the object and print heads may come into contact with each other in the following cases.

• When the height of the object changes due to lifting or warping of the object during printing

• When mass-producing an object whose height varies due to differences among individual objects with-
out changing the height of the registered media

[Flat Table Height Error] appears when the head gap sensor comes in the contact with the object. There-
fore, you can increase the distance between the print object and the print heads in advance with [Flat
Table Lowering Amount], which can be longer than the standard 1.0 mm (0.04 in.).

The flat table is lowered by the [Flat Table Lowering Amount] in advance, so the distance between the
object and the print heads becomes longer. This tends to result in lower print quality, but print time re-
mains the same. However, since the maximum of [Flat Table Lowering Amount] is 2.0 mm (0.07 in.), if
the height of the object varies by 2.0 mm (0.07 in.) or more, adjust the height setting as needed, or incor-
porate [Readjust] into the operation.

[Flat Table Lowering Amount] should be used when print time is a priority.

• This setting is enabled when the height of the object to be printed on is set automatically.
• If the distance is made too long, the print quality may be deteriorated and the nozzles of the print heads may be

clogged.
• Set the printing area so that the difference between the highest printing position of the object and the lowest print-

ing position of the print surface is within 2 mm (0.08 in.) (excluding the [Generic Distance]).

IMPORTANT

Procedure

1. Place an object that is not of uniform height on the flat table.

2. On the Utility home screen, click [Setup].

3. Register the object.

To change the height of an already registered object, proceed from step (4).

(1) Click .

(2) Enter the name of the object, and then click [OK].

(3) In the [Object Type] window, select one of the following, and then click [OK].

Transparent object: Select [Smartphone Cases] or [Others] from the [Transparent] pull-
down menu.

Opaque object: Select [Opaque].

(1) Click [Change] next to [Flat Table Height] to set the height of the object.

(2) Click [▲] next to [Flat Table Lowering Amount], and then set the amount by which the flat table is
lowered.

[Flat Table Lowering
Amount]*1

Distance between print heads and object*2

0.0 mm (0.0 in.) 1.0 mm (39.4 mil)

0.1 mm (3.94 mil) 1.1 mm (0.04 in.)

: :

1.9 mm (0.07 in.) 2.9 mm (0.11 in.)
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[Flat Table Lowering
Amount]*1

Distance between print heads and object*2

2.0 mm (0.08 in.) 3.0 mm (0.12 in.)

 

*1 Can be set in 0.1 mm (3.94 mil) increments.

*2 The highest position
 

(3) Click [OK].

4. Set the print origin.

5. Click [OK].

[Setup in progress.] is displayed, and then setup is performed with the specified [Flat Table Low-
ering Amount].

• Default setting: 0.0 mm (0.0 in.)

MEMO

Flat Table Height Setting

Quality Settings 127



Setting the Reference Position of the Flat Table in the Vertical Direction

Select whether the base position (0 mm [0 in.]) in the flat table height direction should be set to "Lowest
position: Height (H)" or "Highest position: Thickness (T)."

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. In [Flat Table Height/Object (Media) Thickness], select one of the following.

[Height] (H)

0

A
Set the base position (0 mm [0 in.]) as the lowest position
of the flat table. This indicates how much the flat table ris-
es when the object is set up (flat table height: H).

[Thickness]
(T)

0
A

Set the highest position of the flat table to 0 mm. This indi-
cates how much the flat table lowers when the object is set
up (object thickness: T).

A: Print heads

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

• Default setting: [Height (Lowered Flat Table Treated as Height of 0)]

MEMO
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The ingredients in white ink tend to settle. White ink cartridges can be routinely shaken to mix the ink,
but you can mix the ink paths inside the printer by performing [Ink Circulation]. If there is unevenness in
the white ink color, set the frequency of [Ink Circulation] to ensure the white ink concentration.

Setting the [Ink Circulation] Interval

You can set the [Ink Circulation] interval from 30 minutes to 360 minutes in 30-minute increments. How-
ever, if you set the interval too short, you will have to wait more frequently while the ink is circulating.

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Set the interval for performing [Ink Circulation] in [Ink Circulation Interval].

The [Ink Circulation] operation will take a few minutes. Set the intervals as appropriate for your
situation.

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

• Default setting: 360 minutes

MEMO
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Removing/Attaching Optional Items (OA-RA-8)

For information on removing/installing the OA-RA-8, see the OA-RA-8 User's Manual.

https://downloadcenter.rolanddg.com/BD-8

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/g5oVgQ9NXdI

MEMO
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Setting the Deodorizer Mode

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Set the following with [Deodorizer Settings].

• Mode

Mode Deodorizing performance Suction power default set-
tings

[Strong]

Activated when main power is on, sub power is on, or during
printing. This setting emits the least amount of odor to the ex-
terior of the machine. This mode reduces odors coming out of
openings in the machine even when the machine is not in use.
In this mode, you can set the pause time for the deodorizer.

• [When Printing]: 50%
• [When Sub Power On]: 40%
• [When Main Power On]:

20%

[Medium]
Activated when sub power is on, or during printing. This mode
reduces odors when the front cover is opened during opera-
tions such as loading objects.

• [When Printing]: 50%
• [When Sub Power On]: 40%

[Weak]*1
Activated only during printing. This mode is intended for users
in backyards and other areas that are normally unoccupied and
well-ventilated.

• [When Printing]: 50%

[Off] Deodorizing not activated. －

 

*1 Default settings
 

• Suction Power

You can set the suction power for each state. It can be set between 20% and 100% in 10% incre-
ments.

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

 RELATED LINKS 

・  P. 26 Deodorizer

・  P. 133 Setting the Deodorizer Pause Time (Strong Mode Only)
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Setting the Deodorizer Pause Time (Strong Mode Only)

You can specify a time to pause the deodorizer to prevent premature clogging of the filter, to save standby
power, to reduce noise during late-night operation, or for other reasons.

The conditions under which the deodorizer will pause are as follows.

• [Strong] mode

• When main power on or in sleep mode

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Select the [Suspension Time Settings] check box in [Deodorizer Settings].

4. Specify [Suspension Period] and [Resume At].

5. Click [Apply] to confirm your entry.

6. Click [Close] to return to the original screen.

• Default setting: Cleared

MEMO
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Setting the Activation Interval for Sleep Mode (Power-saving Feature)

Set the amount of time until sleep mode (the state in which the power-saving features operate) activates
when the sub power is on and no print data has been received or operations have been performed in Utili-
ty for a long period of time. You can set the [Sleep Time] from 15 to 120 minutes in 15 minute increments.

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Set the [Sleep Time].

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

• Default setting: 30 Minutes

MEMO
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Adjusting the Date and Time

The machine remembers the date and time internally and then prints it out in a nozzle drop-out test. Ad-
just the date and time if it becomes inaccurate over time or if you move to a place with a time difference.

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Set the date and time with [Date and Time].

• When matching the computer's date and time

Select the [Use Date and Time Obtained from Computer] check box.

• When setting the date and time

Enter the year, month, day, hour, minute, and second manually.

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.
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Setting the Language

Procedure

1. On the Utility home screen, click .

2. Click [System Information].

3. Set the language to use in [Language].

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

Exit Utility. The language change will be applied when you restart.
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Setting the Base Position of the Manual Cleaning Tool

When the manual cleaning tool is replaced due to damage or deformation, set the base position.

You can use the pointer to adjust the base position while keeping a close eye on it by working with the front cover
open.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Remove the object, and then cancel the setup.

2. On the Utility home screen, click .

3. Click [Preferences].

4. Click [Execute] under [Adjust Manual Cleaning Tool Position].

If in a setup state, [Execute] will be unavailable.

5. Follow the instructions on the Utility window to adjust the position of the manual cleaning tool.

(1) When the [This starts manual cleaning tool position adjustment.] window appears, click [OK].

(2) Open the front cover.

(3) Attach a new manual cleaning tool.

(4) Close the front cover.

(5) Click [OK].

The print-head carriage and flat table move, and then the pointer illuminates near the base
position of the manual cleaning tool.

(6) Click , , , or  to align the pointer to the manual cleaning tool reference

position.

Good

No
Good

(7) Click [OK].

The print-head carriage and flat table return to their original positions.
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(8) When [Remove the manual cleaning tool.] is displayed, open the front cover and remove the man-
ual cleaning tool.

(9) Click [OK].

(10) Close the front cover.

6. Click [Close] to return to the original screen.
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Adjusting the Pointer Position

Adjust the pointer's printing position if there is misalignment between the printing area set by the pointer
and the actual printing.

You can use the pointer to adjust the base position while keeping a close eye on it by working with the front cover
open.
However, clicking [OK] with these settings configured may cause the print-head carriage or flat table to start moving.
Therefore, when the front cover is open, be careful not to touch any moving parts as you work.

IMPORTANT

Procedure

1. Set up the nozzle drop-out test paper.

P. 31 Registering and Setting Up the Nozzle Drop-out Test Paper

2. On the Utility home screen, click .

3. Click [Preferences].

4. Click [Execute] under [Position Adjustment]>[Adjust Pointer Position].

5. When the [This prints the position adjustment pattern.] window appears, click [OK].

After printing a pattern for position adjustment the pointer illuminates near the printed pattern.

6. Adjust the position of the pointer.

(1) Click , , , and  to move the pointer inside the inner square.
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(2) Click [OK].

The corrected pointer position is applied and the sub power is turned off.
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Checking the Height of the Object before Printing

When you have finished setting up the object, the clearance between the head gap sensor (A) and the ob-
ject (B) is set to 0.5 mm (0.02 in.)*1.

This machine prints while the object moves from the front to the back (from the right to the left in the
above figure).

Depending on the object, the height may change after setup due to such factors as warping of the media
causing the tape that secured the object to peel off. In such cases, the object may come into contact with
the head gap sensor and damage it.

If it is difficult to secure the object, if inexperienced operators are using the machine, and in similar situa-
tions, we recommend that you configure the [Operation before Printing] setting to check the height of
the object before printing. Note, however, that enabling this setting increases the time before printing
starts. Configure this setting appropriately according to the level of user experience and the secured state
of the object.

Procedure

1. On the Utility home screen, click .

2. Click [Preferences].

3. Select the [Check Media Height before Starting Printing] check box.

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

• Default setting: Cleared

MEMO

*1 When there is no [Flat Table Lowering Amount] setting
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Changing the Units of Measurement

Set the units displayed in Utility.

Procedure

1. On the Utility home screen, click .

2. Click [System Information].

3. In [Units], set [Length] and [Temperature].

4. Click [Apply] to confirm your entry.

5. Click [Close] to return to the original screen.

Changes to the display unit settings are applied when you restart Utility.

• Default settings

• [Length]: mm
• [Temperature]: °C

MEMO

 RELATED LINKS 

・  P. 35 Starting/Exiting Utility
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Viewing Printer Information

This is a method for viewing information of this machine, such as serial number and ink type.

You can set the [Nickname] with Roland DG Connect.

MEMO

Procedure

1. On the Utility home screen, click .

2. Click [System Information] and check [Machine Information].

You can check the following information:

• [Model]: Model name

• [Nickname]: Nickname of the machine

• [Serial Number]: Serial number of the machine

• [Ink Type]: Ink type

• [Firmware Version]

• [MAC Address]

3. Click [Close] to return to the original screen.
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Viewing Network Information

Use the following procedure to view network information such as the IP address and default gateway.

Procedure

1. On the Utility home screen, click .

2. Click [System Information] and check [Network].

You can check the following information:

• [Obtain IP Address Automatically]: Enables/disables the automatic obtaining of IP addresses
via DHCP.

• [IP Address]

• [Subnet Mask]

• [Default Gateway]

3. Click [Close] to return to the original screen.

• For information on how to set up a network, refer to Changing the Network Settings.

MEMO

System Settings

144  Advanced Settings



Checking the Utility Version

The most recent version of Utility is continually used via Roland DG Connect. Check the version of Utility
when necessary in cases such as network trouble.

Procedure

1. On the Utility home screen, click .

2. Click [System Information] and check [Version].

You can check the version of Utility here.
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Changing the Network Settings

This section explains how to configure the settings when using the machine with a fixed IP address.

Step 1: Determine the network addresses.

The settings listed here are only an example. The procedure and settings given in this manual do not
match every environment. In an environment where the computer being used is connected to multiple net-
work devices and the Internet, inappropriate settings will have a large effect on the entire network. For
detailed information about the settings, consult your network administrator.

Determine the IP addresses, subnet mask, and default gateway to connect the computer and this machine
to a network.

Procedure

1. Determine the IP addresses.

• Computer: 192.168.0.XXX

• Device: 192.168.0.YYY

"XXX" and "YYY" represent numbers from 1 to 254. Ensure that they are different from the num-
bers of other network equipment.

2. Determine the subnet mask.

• Computer: 255.255.255.0

• Device: 255.255.255.0

Use the same number for the computer and this machine.

3. Determine the default gateway.

• Computer: 192.168.0.AAA

• Device: 192.168.0.AAA

"AAA" represents numbers from 1 to 254. It may not be necessary to set this number, so check
with your network administrator.
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Step 2: Change the IP address.

Procedure

1. On the Utility home screen, click .

2. Click [System Information].

3. Clear the [Obtain IP Address Automatically] check box under [Network].

4. Enter the machine network addresses determined under Step 1: Determine the network addresses..

5. Click [Apply].

6. Click [Close] to return to the original screen.

7. Start Roland DG Connect Hub.

8. Click [Settings], and then clear the [Auto printer registration] check box.

9. Click [Settings]>[Printer settings].

10. Click [+], and then enter the IP address determined under Step 1: Determine the network addresses.
in the address field.

11. Click [Verify], and then click [Apply].

12. Click [OK].

If it is not possible to connect the computer and the machine during reinstallation (such as when relocating a
machine with a fixed IP address), press the reset button to switch to automatic IP address acquisition.

MEMO
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1. Switch off the sub power.
2. Use a paper clip or something similar to hold down the reset button (A) for 5 seconds or longer.

You will hear a short beep when you press the reset button. If you hold down this button for at least 5 sec-
onds from this point, you will hear two short beeps and the machine will reset.
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Step 3: Setting the Computer's Network

Procedure

1. Log on to Windows as the [Administrator] or a member of the [Administrators] group.

2. Display the network connections screen.

• Windows 11

a. Click [Start]>[Settings].

b. Click [Network & Internet]>[Dial-up].

c. Click [Network and Sharing Center].

d. Click [Ethernet] or [Wi-Fi].

• Windows 10

a. Click [Start]>[Settings]>[Network & Internet].

b. Click [Network and Sharing Center].

c. Click [Ethernet] or [Wi-Fi].

3. Click [Properties].

If a [User Account Control] window appears, click [Continue].

The [Ethernet Properties] or [Wi-Fi Properties] window appears.

4. Select [Internet Protocol Version 4 (TCP/IPv4) Properties], and then click [Properties].

If the [Internet Protocol] check box is clear, select it.
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5. Select [Use the following IP address] and enter the computer network address that was determined in
Step 1: Determine the network addresses..
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6. Click [OK].

7. Close all the windows opened for the network settings.
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Step 4: Configure the FlexiDESIGNER settings.

Procedure

1. Open Roland DG Connect Hub.

2. Select the machine to connect to, and then click [Open] next to [VersaWorks 6].

3. Set the machine to connect to FlexiDESIGNER.

VersaWorks will automatically search for and register the connectable printers. However, if the
search finds zero printers or five or more printers, you will have to register printers manually.

• When the detected number of printers is one to four

a. Check the detected printer(s) and click [OK].

b. When the message [Do you want to install the virtual printer driver?] is displayed, click
[Yes].

This message does not indicate the printer driver to use in communication. It indicates the
virtual printer driver to use when printing directly from the application.

c. When the [User Account Control] window appears, click [Yes] (or [Allow]).

d. When the [Add Printer Wizard] window appears, click [Continue].

Registration is complete once the machine information is displayed in the top menu.

• When no printers or five or more printers are detected

a. Enter the IP address of the printer and click [Verify].

Items such as the [Model Name] and [Firmware Version] are displayed.

If the printer is not displayed, check the LAN cable connection status.

MEMO

b. Set the [Nickname].

If you do not set a nickname, the model name is displayed.

c. Click [Apply].
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b

c

a

d. When the message [Do you want to install the virtual printer driver?] is displayed, click
[Yes].

This message does not indicate the printer driver to use in communication. It indicates the
virtual printer driver to use when printing directly from the application.

e. When the [User Account Control] window appears, click [Yes] (or [Allow]).

f. When the [Add Printer Wizard] window appears, click [Continue].

The information of the connected printer appears in the [Printer List].

g. Click [OK].

Registration is complete once the machine information is displayed in the top menu.
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This machine is a precision device. To ensure the full performance of this machine, be sure to observe the
following important points. Failure to observe them may not only result in loss of performance, but may
also cause malfunction or breakdown.

Printer Unit

• This machine is a precision device.

• Never subject the machine to impacts or excessive force.

• Never needlessly put your hand or fingers inside the cover, the ink-cartridge ports, or other inter-
nal areas of the machine.

• Install in a suitable location.

• Install the machine in a location having the specified temperature and relative humidity.

• Install the machine in a quiet, stable location offering good operating conditions.

• The print heads and the UV-LED device are delicate devices.

• Never needlessly touch or allow the object to be printed on to scrape them. Failure to handle with
care may cause damage.

• The print heads may be damaged if allowed to dry out. The machine prevents desiccation auto-
matically, but improper operation may render this feature inoperative. Operate properly, as speci-
fied in this manual.

• Never leave the machine with an ink cartridge removed. Remaining ink in the printer may harden
and clog the print head nozzles.

• Daily maintenance as well as various types of maintenance depending on the status must be per-
formed. Read this manual thoroughly and perform the appropriate maintenance at the appropriate
times.

• The print heads are components that wear out. Periodic replacement is required, with the fre-
quency of replacement depending on use.

Ink Cartridges

• Ink cartridges come in various types.

• Use a type that is compatible with the printer. Also, be sure to use only genuine items from Roland
DG Corporation.

• Never subject ink cartridges to impacts and never attempt to disassemble ink pouches.

• Never drop the ink cartridges or shake them forcefully. The impact may rupture the internal
pouches and cause the ink to leak.

• Never attempt to disassemble.

• Never attempt to refill the ink.

• If ink gets on your hands or clothing, wash it off as soon as possible. Removal may become difficult
if allowed to stand.

• Storage

• Use up the ink before the expiration date printed on the ink cartridge.

• Store the ink cartridge in a location that is not subject to direct sunlight or strong illumination.

• Store the ink cartridges unopened in a well-ventilated location at a temperature of 5°C (41°F) or
higher and less than 40°C (104°F) and a relative humidity of 20% RH to 80% RH.

Important Notes on Handling and Use
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Automatic Maintenance Feature and Notes

This machine has a feature that automatically performs maintenance periodically. This feature performs
operations such as ones that prevent the print heads from drying out, so:

• Always keep the main power switched on.

• Do not use the machine with one or more covers open.

• Never leave the machine with an ink cartridge removed.

• Never leave the machine with an empty ink cartridge.

• Keep track of the amount of discharged fluid.

During repairs, part replacements, and similar work, never perform any operations that are not written in the user's
manual. Be sure to contact your authorized dealer.

IMPORTANT

Dispose of drain packs, used cleaning sticks, replacement parts (wipers, felt wipers, cap tops, filters for deodorizers),
and cloths with discharged fluid or ink on them properly in accordance with the laws in effect in your area.
Discharged fluid is flammable and contains toxic ingredients. Never attempt to incinerate discharged fluid or cloths
with discharge fluid adhere to them, or discard it with ordinary trash. Also, do not dispose of discharged fluid in sewer
systems, rivers, or streams. Doing so may have an adverse impact on the environment.

IMPORTANT

Basic Maintenance Knowledge
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Types and Timing of Maintenance

To use this machine under its optimal conditions, it is important to perform the appropriate maintenance
at the appropriate times.

Regular Maintenance

These are the maintenance items that are required on a daily or periodic basis.

Timing Item Refer to

Before work

Mixing ink cartridges (white ink) P. 163 Maintenance of Ink Cartridges

Checking and cleaning the print
heads

P. 64 Performing a Nozzle Drop-out Test

P. 66 Performing Normal Cleaning

After work Cleaning the machine P. 164 Cleaning the Machine

When a message appears
Manual cleaning P. 168 Manual Cleaning Method

Cleaning the UV-LED device P. 174 Cleaning the UV-LED devices

Advanced Maintenance

This is maintenance that is performed when problems occur. Some of this maintenance also consumes a
large amount of ink, so thoroughly read the explanation, and then perform the operation at the appropri-
ate point in time.

Timing Item Refer to

When dot drop-out or dot dis-
placement occurs

Each type of cleaning through ink
renewal

P. 160 Action Taken When Dot Drop-out or
Dot Displacement Occur

When uneven color issues occur
(white ink)

Ink mixing through each type of
cleaning

P. 161 Action Taken When Uneven Color Is-
sues Occur (White Ink)

Replacing Consumable Parts

These items are for replacement of consumable parts. Thoroughly read the explanation, and then perform
the operation at the appropriate point in time.

Timing Item Refer to

When a message appears

Drain pack P. 188 Replacing the Drain Pack

Wiper P. 192 Replacing the Wiper

Felt wiper P. 194 Replacing the Felt Wiper

Cap top P. 196 Replacing the Cap Top

Every year or when an odor is no-
ticed in the vicinity of the ma-
chine

Deodorizer filter P. 202 Replacing the Deodorizer Filter

Basic Maintenance Knowledge
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When Not in Use for a Prolonged Period

In advance, insert ink cartridges that have a large amount of ink remaining.

If the ink runs out, the machine will not be able to periodically perform automatic maintenance. If the
machine is left in this state, the print heads may malfunction. If you know that you will not use the
machine for a prolonged period, insert ink cartridges that have a large amount of ink remaining.

Switch the sub power on once every two weeks.

Switch the sub power on once every two weeks. When you turn on the power, the machine automatical-
ly performs operations such as those to keep the print heads from drying out. Leaving the machine un-
used for a prolonged period may damage the print heads, so be sure to switch on the power to perform
these automatic operations.

Keep the machine at a constant temperature and relative humidity.

Even when the machine is not in use, keep it at a temperature of 5 to 40°C (41 to 104°F) and a relative
humidity of 20 to 80% (with no condensation). Failure to do so may result in malfunction.

Discharged fluid will increase even when the sub power is off.

Maintenance work is performed even when the sub power is off. Generally speaking, it takes about 11
months from the time the drain pack is new for the discharged fluid to fill up. For information about
purchasing drain packs, contact your authorized dealer.

Do not reuse drain packs. Doing so makes it impossible to manage the amount of discharged fluid, which may over-
flow.

IMPORTANT

 RELATED LINKS 

・  P. 188 Replacing the Drain Pack
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Action Taken When Dot Drop-out or Dot Displacement Occur

This is the procedure for taking action when there is dot drop-out or dot displacement. A large amount of
ink is consumed in some operations. Also, because the print heads themselves are prone to damage, do not
perform such operations more than necessary.

Procedure

1. Perform Normal Cleaning.

If the issue does not resolve after performing this operation two or three times, proceed to the
next step.

2. Perform Medium Cleaning.

If the issue does not resolve after performing this operation two or three times, proceed to the
next step.

3. Perform Powerful Cleaning.

If the issue does not resolve after performing this operation two or three times, proceed to the
next step.

4. Perform Manual Cleaning.

If the issue does not resolve after performing this operation one time, proceed to the next step.

5. Perform Ink Renewal.

If Ink Renewal fails to resolve the issue, contact your authorized dealer.

Basic Maintenance Knowledge
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Action Taken When Uneven Color Issues Occur (White Ink)

This is the procedure for taking action when color unevenness occurs for white ink. A large amount of ink
is consumed in some operations. Also, because the print heads themselves are prone to damage, do not
perform such operations more than necessary.

Procedure

1. Perform Maintenance of Ink Cartridges.

Proceed to the next step if the issue is not resolved even after thoroughly mixing the ink cartridge.

2. Perform [Ink Circulation].

(1) On the Utility home screen, click .

(2) Click [Execute] under [Maintenance]>[Ink Circulation].

The ink in the ink paths is circulated. If the issue does not resolve after performing this oper-
ation one time, proceed to the next step.

3. Perform Powerful Cleaning.

If the issue does not resolve after performing ink circulation two or three times, proceed to the
next step.

4. Perform Ink Renewal.

If the issue does not resolve after performing this operation one time, proceed to the next step.

5. Perform Medium Cleaning.

If the issue does not resolve after performing ink circulation two or three times, contact your au-
thorized dealer.

Basic Maintenance Knowledge
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Regular Maintenance
Daily or Periodic Maintenance ...................................................................... 163

Maintenance of Ink Cartridges ............................................................... 163
Cleaning the Machine.......................................................................... 164
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Maintenance of Ink Cartridges

The precipitation of the ingredients in the ink disables printing in normal color. So that the ink mixes well,
pull out the ink cartridge, and shake the ink cartridge 50 times (about 20 seconds) horizontally with a
stroke length of around 5 cm (1.97 in.) from each end of the ink cartridge before reinserting it.

Shake the ink cartridges:

• All inks: When replaced with a new product.

• White ink: Each day (before starting the day's operations).

The ingredients of white ink have a tendency to separate and settle. Each day, before starting the
day's operations, be sure to shake this cartridge. Allowing the ink to stand can cause the settled mate-
rial to harden, resulting in malfunctions or other problems.

• Before shaking the ink cartridge, wipe off any ink from around its mouth. If you do not wipe off the ink, it may
splatter when you shake the ink cartridge.

• When you have finished shaking the ink cartridge, immediately reinstall the ink cartridge. Taking time to reattach
the ink cartridge will adversely affect the ink path.

• Even if you are not using the printer, shake the white ink cartridge 50 times (about 20 seconds) once a week.

IMPORTANT
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Cleaning the Machine

Wipe away any buildup of dust, dirt, or any ink or grime that has adhered to the interior of the machine as
part of daily cleaning.

Never use gasoline, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING

• This machine is a precision device and is sensitive to dust and dirt. Perform cleaning on a daily basis.
• Never attempt to oil or lubricate the machine.
• Before performing this operation, remove any objects to be printed on.

MEMO

Procedure

1. Open the front cover.

Remove any objects or jigs that are on the flat table.

2. Clean the locations shown in the following figure.

A UV-LED device, print-head carriage surface Clean by wiping with a cloth moistened by neutral de-
tergent diluted with water then wrung dry or a soft,
dry cloth.B Vicinity of the flat table

C Vicinity of the deodorizer

If dust and dirt accumulate in the machine, they are likely to affix to the object.

MEMO

3. When you have finished cleaning, close the front cover.
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Normal Cleaning

Procedure

1. Set up the nozzle drop-out test paper.

P. 31 Registering and Setting Up the Nozzle Drop-out Test Paper

2. Click [Cleaning] on the Utility home screen.

3. Select [Normal Cleaning] under [Head Cleaning], and then click [Execute].

[Cleaning in progress.] and an estimate for the remaining cleaning time are displayed on the Utili-
ty home screen.

4. Click [Output] under [Nozzle Drop-out Test].

Printing of the test pattern starts.

5. When printing is complete, open the front cover.

6. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.
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• If the problem persists, try performing normal cleaning again.
• If problems such as dot drop-out and dot displacement persist even after you have performed normal clean-

ing several times, use a different cleaning method.

P. 160 Action Taken When Dot Drop-out or Dot Displacement Occur

MEMO

7. Close the front cover.

If no dot drop-out or dot displacement occurs, preparations for output are finished.

8. Click [Close] to return to the original screen.
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Manual Cleaning

When Manual Cleaning Is Necessary

When the Following Symptoms Occur

It is recommended to perform manual cleaning when any of the symptoms given below occur and cannot
be solved by the processes from normal cleaning through powerful cleaning.

Wiper replacement may also be effective in improving these symptoms.

Dot drop-out or dot displacement Ink drips Dragging dirt

Dust or other foreign matter adheres to
the print heads and impedes correct ink
discharge.

Ink pools in dust or dirt adhered to the
print heads, and drips onto the media.

The phenomenon where dirt or dust accu-
mulates on the print heads.

• If you use up the cleaning sticks and cleaning liquid used for manual cleaning, contact your authorized dealer.
• The print heads are consumable parts and will need to be replaced depending on the frequency of use or usage con-

ditions.

MEMO

 RELATED LINKS 

・  P. 192 Replacing the Wiper
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Manual Cleaning Method

For manual cleaning, use the manual cleaning tool to automatically clean the print heads. Following this,
manually clean the wiper, scraper, and area around the cap top.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Important notes on this procedure

• To prevent the print heads from drying out, finish the manual cleaning within 10 minutes after the automatic clean-
ing. A warning beep sounds after 10 minutes.

• Never use any implements other than the included cleaning sticks. Cotton swabs or other lint-producing items may
damage the print heads. If you use up the cleaning sticks, contact your authorized dealer.

• Use a new cleaning stick per cleaning session. Reusing cleaning sticks may reduce print quality.
• Do not put a cleaning stick that has been used for cleaning into the cleaning liquid. Doing so will deteriorate the

cleaning liquid.
• Stroke the sponges very gently, applying as little pressure as possible. Never rub, scrape, or crush them.

When a warning beep sounds during cleaning
To prevent the print heads from drying out, an alarm sounds about 10 minutes after automatic cleaning finishes. Per-
form the operation by following the message displayed in Utility.
Do not use a manual cleaning tool that may have been deformed by striking or dropping it. Instead, replace it be-
fore cleaning.
Using a deformed manual cleaning tool may prevent manual cleaning from being carried out properly or damage the
machine.
Only attach the manual cleaning tool to the machine when performing manual cleaning work.
The machine's internal operation may cause the flat table and manual cleaning tool to come into contact, damaging the
machine and the manual cleaning tool.

IMPORTANT

Required items

Cleaning stick Cleaning liquid Manual cleaning tool

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/VmDmhUXBdNA

MEMO

Procedure

1. Remove the object to be printed on.

2. If the manual cleaning tool is stored inside the unit, take it out.

3. Close the front cover.
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4. Access the manual cleaning menu using one of the following methods.

• Notifications: Click , and then click  for [The time for manual cleaning has arrived.].

• Click  [Cleaning] on the Utility home screen, then click [Execute] for [Manual Cleaning].

The manual cleaning work procedure is displayed in Utility. Carefully read the on-screen instructions and carry
out the work.

MEMO

5. Wear protective gear (gloves and glasses).

Put on the protective equipment, and then click [Next] in Utility.

6. Prepare a manual cleaning tool.

(1) Apply a large amount of cleaning liquid to the cleaning stick.

(2) Attach the cleaning stick to the manual cleaning tool.

Push in the cleaning stick as far as it will go.
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After installing the cleaning stick, click [Next] in Utility.

7. Open the front cover.

8. Use the manual cleaning tool retaining screw to secure the manual cleaning tool in the position shown in
the figure.

9. Close the front cover.

After closing the front cover, click [Next] in Utility.

Perform automatic cleaning near the print heads.

10. When [Automatic cleaning has finished.] is displayed in Utility, open the front cover and remove the man-
ual cleaning tool.

• Use the cleaning stick to clean the wiper, scraper, and cap top after cleaning the print heads.

• It is recommended that you store the manual cleaning tool in front of the deodorizer.

Store the manual cleaning tool fixing screw so that you do not lose it.

IMPORTANT

11. Close the front cover.

Remove the manual cleaning tool. Close the front cover, and then click [Next] in Utility.

The print-head carriage will move to the left.

12. Open the front cover.
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13. Follow the guidelines below to clean the wiper, scraper, and cap top.

(1) Remove the cleaning stick from the manual cleaning tool.

(2) Clean the right side and top of the wiper.

(3) Clean the scraper.

(4) Clean the four sides around the cap top.

(5) Use the wide surface of the cleaning stick, and then shift it to a different location, pressing the
cleaning stick lightly against the cap top to absorb the dirt there.

(6) Close the front cover.

After closing the front cover, click [Next] in Utility.

14. When cleaning finishes, click [Close] to return to the original screen.
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15. Set up the nozzle drop-out test paper.

P. 31 Registering and Setting Up the Nozzle Drop-out Test Paper

16. Click  [Cleaning].

17. Click [Output] under [Nozzle Drop-out Test].

Printing of the test pattern starts.

18. When printing is complete, open the front cover.

19. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.

• If the problem persists, perform manual cleaning again.
• If problems such as dot drop-out and dot displacement persist even after you have performed manual

cleaning several times, perform [Ink Renewal].

MEMO

If no dot drop-out or dot displacement occurs, preparations for output are finished.

20. Click [Close] to return to the original screen.
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 RELATED LINKS 

・  P. 182 Ink Renewal
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Cleaning the UV-LED devices

When UV-LED Device Cleaning Is Necessary

The UV-LED device is an important component for ink adhesion. It requires periodic and appropriate main-
tenance. It is important to clean the UV-LED device with the appropriate timing.

When [The time for manual cleaning of the UV lamp has arrived.] Appears

This tells you when to clean the UV lamps according to usage conditions in order to maintain stable print-
ing conditions at all times. If you receive this notification, be sure to perform UV lamp cleaning.

When There Is a Lot of Scattered Ink Mist and the Inside of the Machine is Soiled

Perform this cleaning every day when frequently printing with the print heads at a distance from the print
surface or when ink is emitted to locations that protrude from the print surface. If the scattered ink mist
is allowed to harden, it may cause malfunctions.

When the Irradiation Surfaces of the UV-LED Device Are Dirty (see the following figure)
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UV Lamp Manual Cleaning Method

Important notes on this procedure

• Before performing this operation, remove any objects to be printed on.
• To prevent the print heads from drying out, finish this procedure in 10 minutes or less. A warning beep sounds after

10 minutes.
• The cloths, alcohol, and similar items used in cleaning are not included with the product.

IMPORTANT

Required items

Anhydrous ethanol or isopropyl alcohol Cloth (that is not fluffy)

Do not perform cleaning immediately after printing has finished. (Wait approximately 15 minutes
after printing finishes.)
The area around the UV-LED device is hot and may cause burns.

CAUTION

When using anhydrous ethanol or isopropyl alcohol, be sure to follow the product's usage precau-
tions.
Exercise caution regarding items such as fire, ventilation, and rashes.

CAUTION

Only use anhydrous ethanol or isopropyl alcohol.
Using chemicals (or similar substances) other than anhydrous ethanol or isopropyl alcohol may lead to UV-LED device
damage.

CAUTION

Use cloth that is not fluffy to wipe off the parts. Do not use a hard material such as metal.
Using cloth that is fluffy or a hard material such as metal may lead to UV-LED device damage.

CAUTION

Procedure

1. Remove the object, and then close the front cover.

2. Access the manual cleaning menu using one of the following methods.

• Notifications: Click , and then click  for [The time for manual cleaning of the UV

lamp has arrived.].
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• On the Utility home screen, click , then click [Execute] for [UV Lamp Manual Cleaning]
under [Maintenance].

The print-head carriage moves to near the center.

3. Open the front cover, and then remove the maintenance cover.

4. Touch the location shown in the figure (next to the ink slots) to discharge any static electricity.

5. Wear protective gear (gloves and glasses).

6. Click [OK].

The print-head carriage and flat table move.

7. Wet a cloth with anhydrous ethanol or isopropyl alcohol, and then wipe off the irradiation surface of the
UV-LED device with this cloth.

Wipe the cloth across each UV lamp for approximately 10 round trips until all the dirt is cleared
away.

After you have wiped off the dirt, click [Next].

8. Attach the maintenance cover, and then close the front cover.

9. Click [Finish].

The print-head carriage returns to its original position.
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Medium Cleaning

When problems such as dot drop-out and dot displacement are not resolved by normal cleaning, perform
the more forceful [Medium Cleaning] to remove clogging from the print heads nozzles.

Medium cleaning consumes more ink than normal cleaning. Because the print heads are prone to damage if cleaned too
frequently, do not perform cleaning more than necessary.

MEMO

Procedure

1. Set up the nozzle drop-out test paper.

2. Click [Cleaning] on the Utility home screen.

3. Select [Medium Cleaning] for [Head Cleaning], and then click [Execute].

[Cleaning in progress.] and an estimate for the remaining cleaning time are displayed on the Utili-
ty home screen.

4. Click [Output] under [Nozzle Drop-out Test].

Printing of the test pattern starts.

5. When printing is complete, open the front cover.

6. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.
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• If the problem persists, try performing medium cleaning again.
• If problems such as dot drop-out and dot displacement persist even after you have performed medium

cleaning two or three times, perform the more forceful [Powerful Cleaning].

MEMO

If no dot drop-out or dot displacement occurs, preparations for output are finished.

7. Close the front cover.

8. Click [Close] to return to the original screen.

 RELATED LINKS 

・  P. 180 Powerful Cleaning
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Powerful Cleaning

When problems such as dot drop-out and dot displacement are not resolved by medium cleaning, perform
the more forceful [Powerful Cleaning] to remove clogging from the print head nozzles.

Powerful cleaning consumes more ink than medium cleaning. Because the print heads are prone to damage if cleaned
too frequently, do not perform cleaning more than necessary.

MEMO

Procedure

1. Set up the nozzle drop-out test paper.

2. Click [Cleaning] on the Utility home screen.

3. Select [Powerful Cleaning] for [Head Cleaning], and then click [Execute].

[Cleaning in progress.] and an estimate for the remaining cleaning time are displayed on the Utili-
ty home screen.

4. Click [Output] under [Nozzle Drop-out Test].

Printing of the test pattern starts.

5. When printing is complete, open the front cover.

6. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.
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• If the problem persists, try performing powerful cleaning again.
• If problems such as dot drop-out and dot displacement persist even after you have performed powerful

cleaning several times, perform [Manual Cleaning].

MEMO

If no dot drop-out or dot displacement occurs, preparations for output are finished.

7. Close the front cover.

8. Click [Close] to return to the original screen.

 RELATED LINKS 

・  P. 167 Manual Cleaning
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Ink Renewal

This is used to correct dot drop-out or dot displacement, and to restore ink density that cannot be fixed by
any means.

To replace the ink in the path, a large amount of ink is consumed and then discharged as discharged fluid. Do not do
this frequently.

IMPORTANT

Procedure

1. Set up the nozzle drop-out test paper.

2. On the Utility home screen, click .

3. Click [Execute] for [Ink Renewal] under [Maintenance].

Starts the [Ink Renewal] function.

4. When ink renewal is finished, click [Output] under [Nozzle Drop-out Test].

5. When printing is complete, open the front cover.

6. Check whether there is dot drop-out or dot displacement in the test pattern.

Missing blocks indicate dot drop-out. Collapsed or inclined blocks indicate dot displacement.

• If no dot drop-out or dot displacement occurs, preparations for output are finished.

• If there still is dot drop-out or dot displacement, contact your authorized dealer.

7. Close the front cover.

8. Click [Close] to return to the original screen.
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Ink Discharge

Perform in advance the ink discharge which is otherwise performed regularly. Perform beforehand in cases
when you want to perform printing immediately, such as for a demo.

Because [Ink Discharge] is performed automatically in ordinary maintenance, it is not necessary for the user to execute
it.

MEMO

Procedure

1. On the Utility home screen, click .

2. Click [Execute] for [Ink Discharge] under [Maintenance].

Starts the [Ink Discharge] function.
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Out-of-ink Warnings

When an ink pouch runs out, printing pauses and [Ink Cartridge Error] appears.

When the ink runs out,  is displayed in the Utility home screen, and [Ink has run out.] is displayed in
notifications. Replace the empty ink cartridge as soon as possible.

• K: Black

• C: Cyan

• M: Magenta

• Y: Yellow

• Pr: Primer

• Wh: White

Never reuse an ink cartridge for which [Ink has run out.] is displayed.
Even if [Ink has run out.] is displayed, there may be a small amount of ink remaining in the cartridge. Such an ink
cartridge is in a state where drawing ink from it is impossible, so using it in such a state may force air into the ink path
and cause malfunctions.

IMPORTANT

Replacing Ink Cartridges
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Replacing Ink Cartridges

Never store ink, cleaning liquid, or discharged fluid in any of the following locations.

• Any location exposed to open flame

• Any location where high temperature may occur

• Near bleach or any other such oxidizing agent or explosive material

• Any location within the reach of children
Fire may be a danger. Accidental ingestion by children may pose a health hazard.

WARNING

Important notes on replacing cartridges

• Replace the cartridge with an item of identical type and color.

• Insert the cartridge so that the side with the arrow faces up.
• Insert and remove cartridges slowly, one at a time.
• Insert the cartridge firmly, as far as it will go.

• Never mix different types of items.
• Never leave the machine with an ink cartridge removed. The nozzles of the print heads may become clogged.

IMPORTANT

Never reuse an ink cartridge for which [Ink has run out.] is displayed.
Even if [Ink has run out.] is displayed, there may be a small amount of ink remaining in the cartridge. Such an ink
cartridge is in a state where drawing ink from it is impossible, so using it in such a state may force air into the ink path
and cause malfunctions.

IMPORTANT

Procedure

1. Open the front cover.

2. Pull out the empty ink cartridge.

3. Gently shake the new ink cartridge.

During storage, the ink components may have precipitated. The precipitation of the ingredients in
the ink disables printing in normal color. So that the ink mixes well, shake each ink cartridge 50
times (about 20 seconds) horizontally with a stroke length of around 5 cm (1.97 in.) from each end
of the ink cartridge before inserting it.

4. Insert the ink cartridge into its ink slot.

Replacing Ink Cartridges
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Orient the ink cartridge so the arrow or protrusion is on top, and then insert the ink cartridge in
the direction shown in the figure as far as it will go.

5. Close the front cover.
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Replacing the Drain Pack

Ink left in the print heads after printing or ink used for head cleaning is called discharged fluid. The dis-
charged fluid is collected in a drain pack, and when the specified amount is reached, a replacement mes-
sage is displayed in Utility.

There are two types of messages for replacing the drain pack. The message displayed depends on the
amount of discharged fluid.

1. [When output, cleaning, and other operations are completed, discard the discharged fluid.]

At this time, the drain pack has not reached the limit of its use. It can continue to be used if, for ex-
ample, a replacement drain pack is not readily available. However, the drain pack should be replaced
as soon as possible.

2. [Replace the drain pack.]

This indicates the usage limit of the drain pack. If this error appears, the drain pack can no longer be
used.

The machine is calculating the total amount of discharged fluid. When the amount of discharged fluid
reaches near the capacity of the drain pack, the system will issue a message to replace it. If the dis-
charged fluid is not disposed of according to the following procedure, the amount of discharged fluid will
not be reset and it will be impossible to control the discharged fluid.

Be sure to replace the drain pack as directed in the displayed message.

Also, if you know that you will not use the machine for a prolonged period, follow the procedure below to
replace the drain pack.

Never place the drain cartridge or ink near an open flame.
Doing so may cause a fire.

WARNING

Before you remove the drain cartridge, wait for a message to be displayed in Utility.
Failing to follow this procedure may cause discharged fluid to flow out of the tube and spill, soiling your hands or the
floor.

CAUTION

When temporarily storing drain packs, you can store them in a sealed container or plastic bag.
Any spillage or vapor leakage may cause fire, odor, or physical distress.

CAUTION

• Do not reuse drain packs.
Doing so makes it impossible to manage the amount of discharged fluid, which may overflow.

• Dispose of discharged fluid properly, in accordance with the laws in effect in your locale.
Discharged fluid is flammable and contains toxic ingredients. Never attempt to incinerate discharged fluid or discard
it with ordinary trash. Also, do not dispose of it in sewer systems, rivers, or streams. Doing so may have an adverse
impact on the environment.

IMPORTANT
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Required item

Drain pack

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/Uw8XZQpKlv8

MEMO

Procedure

1. Open the front cover, and then remove the maintenance cover.

2. Wear protective gear (gloves and glasses).

3. Remove the drain cartridge.

Pull the drain cartridge out until you can support its base with your hand. Then, remove this car-
tridge by holding its handle and its base.

Do not drop the drain cartridge or subject it to impacts. Damage to the protrusion on the drain cartridge will
make it impossible for the machine to recognize the drain cartridge, and the [The drain cartridge was re-
moved.] message will be displayed continuously even when the drain cartridge is installed.

IMPORTANT
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4. Release the hooks in two locations to unlock the drain cartridge lid, and then open it.

5. Lift up the flap of the drain pack to remove it from the drain cartridge.

Pull up the drain pack by holding its sides, as pulling it by the flap may tear it.

Ink adheres when touching the drain pack's hole.

MEMO

6. Insert a new drain pack into the drain cartridge.

Insert the drain pack so its hole (B) is on the opposite side to the handle (A) of the drain cartridge.
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7. Close the drain cartridge lid.

Align the hole in the lid of the drain cartridge and the drain pack's hole, and then close the lid
from the handle side. If the lid is not flush with the cartridge, gently press down around the cir-
cumference of the lid to fit it into the cartridge.

8. Insert the drain cartridge into the machine.

Put your hand on the bottom of the drain cartridge and push it in slowly with the horizontal or
handle side in a slightly raised state.

9. Attach the maintenance cover, and then close the front cover.

10. When [Has the drain pack been replaced with a new one?] appears, click [Yes] to close the message.

For information about purchasing drain packs, contact your authorized dealer.
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Replacing the Wiper

The wiper is a component that is used for cleaning the print heads.

You will be notified with [The time for wiper replacement has arrived.] when it is time to replace the
wiper, so replace it when you are so notified.

For information about purchasing wipers, contact your authorized dealer.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

When the warning alarm sounds during wiper replacement
To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the operation. Perform
the operation by following the message displayed in Utility.

IMPORTANT

Required items

Wiper Tweezers

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/JGrvlQDaxfc

MEMO

Procedure

1. Remove the object to be printed on.

2. Click  on the Utility home screen to display the message.

3. Click  under [The time for wiper replacement has arrived.].

The [Wiper Replacement] window appears.

4. Put on protective equipment (gloves and glasses), and then click [OK].

The print-head carriage moves to a location where wiper replacement is possible.

5. Follow the on-screen instructions and perform the procedure below to replace the wiper.

(1) Open the front cover.

(2) Disconnect the hooks ( ), and then pull the wiper up and out ( ).
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(3) Insert a new wiper as shown in the figure.

Install the wiper so the slanted part with dashed lines is at the back.

(4) Attach the wiper to the hooks.

(5) Click [Next].

6. When the operation is complete, close the front cover.

7. Click [Finish].

The print-head carriage returns to the original position, and then head cleaning starts. When head
cleaning finishes and two short beeps sound, the work is complete.
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Replacing the Felt Wiper

The felt wiper is a component that is used for cleaning the print heads.

You will be notified with [The time for felt wiper replacement has arrived.] when it is time to replace
the felt wiper, so replace it when you are so notified.

For information about purchasing felt wipers, contact your authorized dealer.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

When the warning alarm sounds during felt wiper replacement
To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the operation. Perform
the operation by following the message displayed in Utility.

IMPORTANT

Required items

Felt wiper Tweezers

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/dQCQqWV16kA

MEMO

Procedure

1. Remove the object to be printed on.

2. Click  on the Utility home screen to display the message.

3. Click  under [The time for felt wiper replacement has arrived.].

The [Felt Wiper Replacement] window appears.

4. Put on protective equipment (gloves and glasses), and then click [OK].

The print-head carriage moves to a location where felt wiper replacement is possible.

5. Follow the on-screen instructions and perform the procedure below to replace the felt wiper.

(1) Open the front cover.

(2) Disconnect the hooks ( ), and then pull the felt wiper up and out ( ).
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(3) Insert a new felt wiper.

(4) Attach the felt wiper to the hooks.

(5) Click [Next].

6. When the operation is complete, close the front cover.

7. Click [Finish].

The print-head carriage returns to the original position, and then head cleaning starts. When head
cleaning finishes and two short beeps sound, the work is complete.
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Replacing the Cap Top

The cap top is a protective part that prevents the print heads from drying out.

You will be notified with [The time for cap top replacement has arrived.] when it is time to replace the
cap top, so replace it when you are so notified.

For information about purchasing cap tops, contact your authorized dealer.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

When the warning alarm sounds during cap top replacement
This operation consists of three procedures: replacement, cleaning, and confirmation. To prevent the print heads from
drying out, a warning beep sounds about 30 minutes after the start of replacement and about 5 minutes after the start
of post-cleaning confirmation. If this beep sounds, perform operations by following the message displayed in the Utility
window.

IMPORTANT

Cap top replacement involves the process of removing the ink tube. If the removed tube is exposed to ultraviolet light,
the ink may cure inside the tube.
If the area around the cap top is dark, use a light that does not emit UV light (light with a wavelength of 450 nm or
shorter).

MEMO

Required item

Cap top Twist ties (2)*1

 

*1 Use two of the three twist ties included with the replacement cap top. The remaining twist tie is a spare.
 

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/ufzWC3gW55o

MEMO

Procedure

1. Remove the object to be printed on.

2. Click  on the Utility home screen to display the message.

3. Click  under [The time for cap top replacement has arrived.].
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The [Cap Top Replacement] window appears.

4. Put on protective equipment (gloves and glasses), and then click [Next].

The print-head carriage moves to a location where cap top replacement is possible.

5. Follow the on-screen instructions and perform the procedure below to replace the cap top.

(1) Open the front cover.

Open the front cover, and then click [Next].

(2) Push the foundation to which the cap top is attached to the right.

While still pushing the foundation, click [Next].

(3) Remove the cap top.

• The cap top is fixed in place at the three points shown in the figure. Push the cap top
down, and then slide it to the left to dislodge it.

• Once the cap top is removed, release the foundation that was holding it.

After removing the cap top, click [Next].

(4) Remove the spring inserted in the groove on the bottom of the cap top.

If you cannot remove the spring correctly, twist it slightly. This will make it easier to remove
the spring.
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After removing the spring from the groove, click [Next].

(5) Hold the upper part of the tubes, and then remove the cap top from the tubes.

Take care to ensure that the tubes do not fall into the machine.
If the tubes fall into the machine and you cannot remove them, contact your authorized dealer.

IMPORTANT

After removing the cap top from the tubes, click [Next].

(6) Compress the spring.

i. Remove the spring from the foundation.

ii. Compress the spring with twist ties.
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iii. Attach the spring to the foundation.

(7) Attach the new cap top to the tubes.

i. Hold the cap top with the two protrusions on the cap top facing toward the back.

ii. Insert the sleeve (A) at the end of the tubes into the cap top by pinching the end of the
sleeve so as not to push the sleeve deep into the tube.

After inserting the tubes, click [Next].

(8) Remove the twist ties that are compressing the spring.

Release the spring slowly, ensuring that the force of the spring is not suddenly applied to the cap top.

IMPORTANT

(9) While holding the cap top, insert the spring into the bottom of the cap top (A) and the groove on
the foundation (B).

After inserting the spring, click [Next].

(10) Push the foundation to the right.
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While still pushing the foundation, click [Next].

(11) Attach the cap top to the foundation.

Push the cap top down ( ) with the cap top in a horizontal position and slide it to the right
( ).

Correct Attachment

• The cap top is secured in the three positions shown in the figure.
• The cap top and foundation are parallel.

MEMO

After attaching the cap top, click [Next].

(12) When the operation is complete, close the front cover.

6. Click [Next].

The print-head carriage returns to the original position, and then head cleaning starts. When head
cleaning finishes and two short beeps sound, proceed to the next step.

7. Open the front cover, and then check that there is ink on the cap top.
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If there is no ink on the cap top, the tubes may not have been inserted as described in step 5-(7).
Remove the cap top again and check the connection.

8. Close the front cover, and then click [Finish].

The print-head carriage returns to the original position, and then head cleaning starts. When head
cleaning finishes and two short beeps sound, the work is complete.

Replacing Parts for Maintenance

Replacing Consumable Parts 201



Replacing the Deodorizer Filter

We recommend replacing the deodorizer filter every year. However, the deodorizing performance decreas-
es with frequency of use. If you start to smell odors coming from near the machine, replace the filter even
if it has been in use for less than a year.

Handling the Filter

• If the filter is dropped or struck, it will break. Handle it with care.
• Touching or tilting the front and rear surfaces of the filter may cause the activated charcoal to stick to your hands or

fall to the floor. Handle it in such a way that it does not contaminate its surroundings. Also, use gloves if necessary.

MEMO

Required item

Filter

Use the following link to view a reference video for this procedure. We recommend that you view this video to under-
stand the overall flow of work.

https://youtu.be/LXL6ymGf8u0

MEMO

Procedure

1. Turn off the sub power, and then turn off the main power.

2. Open the front cover.

3. If manual cleaning tools are stored in front of the deodorizer, move them.

4. Lift up ( ) the filter holder (A) at the top of the filter and pull the filter toward you ( ) to remove it.

Lift the filter up by holding the rubber at the end of the filter holder.
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5. Install the new filter with the side with the circles pattern facing you.

Install the filter in the orientation shown in the following figure. Installing it backward will shorten the service
life of the filter.

IMPORTANT
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Print Results Are Coarse

Is there any dot drop-out or dot displacement?

Carry out a nozzle drop-out test and make sure no dot drop-out or dot displacement occurs. If dot drop-
out or dot displacement is present, perform head cleaning.

P. 160 Action Taken When Dot Drop-out or Dot Displacement Occur

Are the appropriate settings selected at the time of printing?

Printing quality may seem coarse depending on the [Media Type] and [Print Quality] selected when print-
ing. Check the settings at the time of printing.

Is the printer's installation site appropriate?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Also, never install the machine in a location that is exposed to direct sunlight.

Doing so may result in dot drop-out, dot displacement, or other problems with reduced print quality, or
may even result in malfunction.

Is the object loaded correctly?

If the object is not loaded correctly, printing may be adversely affected. Check the following.

• Is the object securely fixed in place?

• Is the height setting of the object correct?

 RELATED LINKS 
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Print Results Contain Horizontal Bands

Is there any dot drop-out or dot displacement?

Carry out a nozzle drop-out test and make sure no dot drop-out or dot displacement occurs. If dot drop-
out or dot displacement is present, perform head cleaning.

P. 160 Action Taken When Dot Drop-out or Dot Displacement Occur

Has printing been paused partway through?

Resuming printing after pausing while printing was partway through may produce horizontal stripes in the
printing area. Avoid pausing printing.

Print Quality Problems

Troubleshooting Methods 207



Colors Are Unstable or Uneven

Did you shake the ink cartridges before installing them?

Shake new ink cartridges 50 times (about 20 seconds) with a stroke length of around 5 cm (1.97 in.) hori-
zontally in each direction when shaking before you install them.

For white ink, before starting the day's work, remove the ink cartridge and shake it 50 times (about 20
seconds) with a stroke length of around 5 cm (1.97 in.) horizontally in each direction before inserting it
again.

Are colors still uneven after mixing the ink by shaking the ink cartridges?

If uneven color issues with white ink still occur even after shaking the ink cartridges to mix the ink, per-
form step 2 of Action Taken When Uneven Color Issues Occur (White Ink) and subsequent steps.

Are the operating parameters set to appropriate values?

Depending on the [Printing Movement Range], the color may be unstable. If you have changed the set-
ting, try setting to [Full Width].

P. 120 Minimizing Print-head Carriage Movement

Was printing paused partway through?

When printing is paused, the coloring at the seam may be altered when printing resumes. Avoid pausing
printing.

Printing may also pause when data is not sent from the computer quickly enough. We recommend not per-
forming any other tasks with the computer while printing is in progress.

Is the printer installed in a level and stable location?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Doing so may result in reduced print quality.

Are the irradiation surfaces of the UV-LED device dirty?

If the irradiation surfaces are dirty, this can reduce ink adhesion and the quality of the printed materials.
Check the level of dirt and clean at the appropriate times.

P. 175 UV Lamp Manual Cleaning Method

Are you printing in a location subject to severe changes in the operating environment?

Large fluctuations in temperature or humidity while printing is in progress may cause the colors to change
partway through the printing. When printing, use the machine in a location where the temperature and
humidity are stable.
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The Object Becomes Soiled

Are the print heads dirty?

The following may cause ink to drip on the object to be printed on during printing.

• Buildup of fibrous dust (lint) around the print heads.

• The print heads are in contact with the object and ink is adhering to the print heads.
If this happens, perform manual cleaning.

Is the humidity of the room too low?

Use in an environment of 35 to 80% RH (but no condensation).

 RELATED LINKS 

・  P. 167 Manual Cleaning
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Excessive Misting / Nozzle Drops Out / Ink Smearing or Dripping

Is the object charged with static electricity?

If the object is charged with static electricity, the print heads will not be able to discharge ink correctly.
As a result, issues such as mist generation, nozzle drop-out, contamination of the object, ink smearing,
and ink dripping may occur.

Perform the following operations to eliminate static electricity and prevent the generation of static elec-
tricity.

• Remove static electricity from workers.

Workers should wear clothing and shoes that are resistant to generation of static electricity, and touch
a wall or other surface before touching the object to discharge any static electricity from the workers.

• Remove any static electricity from the object.

It is easy for the object to be charged with static electricity when the protective sheet or film is re-
moved from the object. Use a static removal brush or anti-static cloth to discharge any static electrici-
ty from the object.

• Humidify the area around the printer to prevent static electricity generation.

Low temperatures and humidity are conducive to the generation of static electricity. Use the machine
in an environment of 35-80% RH (no condensation), for example, by humidifying the room with a hu-
midifier.
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Ink Adhesion Is Poor

Did you use a primer?

Ink adhesion may be improved by using a primer. After creating print data in FlexiDESIGNER, select "with
primer" in [Print parameters].

Is the print surface soiled?

Ink adhesion will be poor if the print surface is dirty. After loading the object, degrease the print surface
using anhydrous ethanol or isopropyl alcohol.

Are the irradiation surfaces of the UV-LED device dirty?

If the irradiation surfaces are soiled with ink mist or other contaminants, UV illumination may be reduced,
resulting in poor ink adhesion. Perform Cleaning the UV-LED devices.

Is the ambient temperature too low?

Low ambient temperatures in and around the machine, such as low room temperatures or where directly
exposed to air-conditioner breezes, may cause poor ink adhesion. During printing, the ambient tempera-
ture should be set to 20 to 32°C (68 to 89.6°F; 22°C [71.6°F] or higher is recommended).
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Printing Position Using Alignment Markers Is Misaligned

Is the object too thick?

When placing a thick object and then performing imaging of the alignment marker, the thicker the object
is, the more it is enlarged in imaging relative to the size of the flat table, even in the same printing area.
This is the same principle involved when a person in the distance appears smaller and a person nearby ap-
pears larger when performing imaging.

Thin Object Thick Object

a
c

b

ab
a’

c’
b’

b’ a’

Since the alignment markers are printed inside the white line (210 mm × 148 mm [8.26 in. × 5.82 in.]) of
the maximum printing area, when the object is imported into FlexiDESIGNER, it is recognized as a larger
size (a' and c') than the actual size (a and c) and the margins are reduced accordingly (b -> b').

Then, when creating print data in FlexiDESIGNER, the data will be created based on a size larger than the
actual printing size of the object. Since the data created in the enlarged printing area will be printed in
the actual size, misalignment of and extending beyond the printing position will occur.

Therefore, when printing on a thick object, it is necessary to create print data with the assumption that
the object will be enlarged. Refer to the following to create print data that is small relative to the Flexi-
DESIGNER screen.

• Object with thickness 10 mm (0.39 in.) and width 150 mm (5.90 in.): Max. approx. 6 mm (0.23 in.)

• Object with thickness 30 mm (1.18 in.) and width 150 mm (5.90 in.): Max. approx. 17 mm (0.66 in.)

Is there a misalignment between the imaging position and the printing position?

The longer the distance from the center position of the camera (a) to the left/right/front/back, the great-
er the misalignment (the misalignment between c and c' is greater than the misalignment between b and
b').

a ab c b’ c’

When imaging alignment markers and the object to be printed, perform imaging from directly above the
position (d) from which you do not want there to be any displacement. Then, measure the object, deter-
mine the printing size (e), and create print data.
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dd
e

e

Note that the higher the position at which imaging is performed, the smaller the misalignment, but it may
become more difficult to read the alignment markers. The optimal imaging height varies from camera to
camera, so perform imaging several times to find a good balance between the amount of misalignment and
the reading.
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Alignment Markers Cannot Be Read

The alignment markers are out of focus in the image.

If the alignment markers are not in focus in the image, they may not be readable. Perform imaging by fo-
cusing on the alignment markers.

The place where the imaging is performed is too bright/dark.

If you perform imaging in an excessively bright place, the black portion of the alignment marker cannot be
recognized (A), and if you perform imaging in an excessively dark place, the white portion cannot be rec-
ognized (B).

A B

If you perform imaging in a place that is excessively bright or dark, the alignment markers cannot be read
and image conversion will fail.

Perform imaging by adjusting the light shining on the alignment markers.

• Adjust by lowering or raising the flat table

• Adjust room brightness

• Adjust light source position or printer position

• Adjust camera exposure

The brightness difference between the four alignment markers is significant.

If you do not perform imaging of the four alignment markers with the same level of brightness for each
marker, some locations may not be recognizable. If all four markers are not recognized, image conversion
will fail.

Perform imaging by making sure that the brightness is the same for the four alignment markers.

• Adjust by lowering or raising the flat table

• Adjust light source position or printer position

• Adjust by increasing or decreasing the light coming from the light source

The color difference between the alignment markers and the tape is minor.

If the [Print White Alignment Marker Background] check box is cleared, the image conversion will fail if
the tape color cannot be recognized as white.
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Select the [Print White Alignment Marker Background] check box, and then print the alignment markers
again.
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The Printer Unit Does Not Run (Does Not Print)

There is a problem with print data, and the printer does not work.

If the print data is larger than the printing area, it cannot be printed. Check the print data and the print-
ing area, and change the one that is too large.

There is a problem in Utility, network, machine, or other technical issue and the printer does not
work.

Procedure

1. Check for Notifications/Errors/Fatal Errors in Utility, and then take necessary action.

2. Make sure that the print data has been sent normally.

Make sure the machine to be used is selected in the [Send to Device] dialog box.

3. If you have more than one BD-8, make sure the machine you are using is correctly selected in the Roland
DG Connect Hub.

4. Check that the status LED for the LAN cable connector is lit in green.

If the status LED (A) for the LAN cable connector is not lit in green, the network connection has
not been made correctly. Check whether or not the network routing is appropriate. Try connecting
the computer and the machine to the same hub or connecting them directly using a crossover ca-
ble. If this makes it possible to perform output, it means the problem is in the network itself.

The activity LED on the top of the status LED flashes orange while data is being received from the network.

MEMO

5. Make sure that the LAN network settings are correct.

If printing is not possible even though the status LED (green) for the Ethernet connector is lit,
make sure the IP address and other settings are appropriate. The settings on both the machine and
the computer must be appropriate.

Redo the settings, checking to ensure that the IP address does not conflict with the IP address for
another device on the network, that the port setting for the software RIP specifies the IP address
set on the machine, that the settings have no typing errors, and for other such problems.

6. Check that the sub power is turned on.

Check that the sub power button is not lit in red.
P. 15 Machine State Indicated by the Sub Power Button's Lamp
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7. Check that the front cover and maintenance cover are closed.

8. Turn the sub power off and back on again, and then perform the printing operation again.

If it is still not possible to print, contact your authorized dealer.
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Why Has the Print-Head Carriage Stopped Moving?

The print-head carriage stopped above the flat table.

Follow the procedure below to return the print-head carriage to the standby position so that the print
heads do not dry out.

If the same issue occurs again, contact your authorized dealer.

Procedure

1. Check for Notifications/Errors/Fatal Errors in Utility, and then take necessary action.

2. Turn the sub power off, and then back on again.

• If the print-head carriage moves to the home position (the right side), recovery has ended suc-
cessfully.

• If the print-head carriage still does not move, proceed to the next step.

3. Try switching off the sub power, followed by the main power, then switching on the main power again,
followed by the sub power.

• If the print-head carriage moves to the home position (the right side), recovery has ended suc-
cessfully.

• If the print-head carriage still does not move, proceed to the next step.

4. Check the position of the wiper and felt wiper.

• If the wiper or felt wiper touches the print heads, leave the machine as-is and contact your
authorized dealer.

• If the wiper (A) and felt wiper (B) are in a position where they do not contact the print heads*1

as shown in the following figure, proceed to the next step.

5. Follow the procedure below to move the print-head carriage.

This operation is an emergency measure to prevent the print heads from drying out. After perform-
ing this operation, contact your authorized dealer.

(1) Switch off the sub power and main power, and then open the front cover.

(2) Touch the location shown in the figure (next to the ink slots) to discharge any static electricity.

*1 If the position is lower than the dashed line, the print heads and the wiper or felt wiper will not come in contact.
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(3) Gently move the print-head carriage to the right by hand.

The print-head carriage stops once it reaches position . The print-head carriage is fixed in
position  after moving about 15 mm (0.59 in.) further from this position.
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The Flat Table Does Not Move

The flat table stopped working when setting the height and printing area.

Procedure

1. Check for Notifications/Errors/Fatal Errors in Utility, and then take necessary action.

2. Check that the front cover and maintenance cover are closed.

3. Check the lower part of the flat table and the front and rear movable components to make sure that no
foreign objects are caught in them.

Remove any foreign objects you find.

4. Turn off the sub power, turn it on again, and then configure the settings again.
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Printer Is Not Displayed on the Roland DG Connect Hub

The PC on which the Roland DG Connect Hub is installed and the printer are not in the same subnet.

The PC in question and the printer must be located in the same subnet. For details, contact your network
administrator.

The PC on which the Roland DG Connect Hub is installed and the printer cannot be used in the same
subnet.

Connect the PC in question directly to the printer. For information on connection and setup, see "Installa-
tion and Initial Settings."

 RELATED LINKS 

・ BD-8 Installation and Initial Settings

Roland DG Connect Hub Does Not Change from "Loading"

Does your Windows firewall allow communication?

Check your firewall settings.

 RELATED LINKS 

・ Support Site

Network Trouble
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Printing on a Thick, Transparent Object

Transparent objects with a thickness of 20 mm (0.79 in.) or more require more frequent cleaning. To
avoid cleaning during printing, create print data as follows.

• Create print data that is long in the vertical direction, and then print with the printing area arranged
vertically.

You can increase the time until cleaning if the width is 100 mm (3.94 in.) or less.

• When printing white above or below CMYK, print the white plate and the CMYK plate separately.

Introduction to FlexiDESIGNER:https://downloadcenter.rolanddg.com/BD-8
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Printing Without Being Affected by the Color of the Object (White Printing on a
Base)

When printing directly on a dark-colored object, it becomes difficult to hide the base and the CMYK
colors will develop poorly. In addition, transparent objects allow light to penetrate through them,
which also results in poor CMYK color development. To improve CMYK color development, print in
white on the base.

White plates cannot be generated for photo data sizes such as jpeg. If you mask with shapes in FlexiDESIGNER, you can
generate a white plate that conforms to the shapes.

MEMO

Procedure

1. Create CMYK print data in FlexiDESIGNER.

The print data created here does not require the creation of a white plate for the base.

2. Click .

The [Send to Device] window appears.

3. Click [Print parameters].

4. Set the following with [Quality Settings] on the [Quality] tab.

• [Media Type]: User's choice

• [Print Quality]: User's choice

• [Mode]: [White->CMYK]

5. Select the [White Plate Generation] check box in [Special Color Plate Generation].

6. In [Generated Pattern], select the following.

• [Print Area]: A white plate is generated under the CMYK plate.

• [Outside Print Area]: A white plate is generated outside the CMYK plate.

• [Entire Image]: A white plate is generated for the entire printing area.

7. If adjusting the size of the white plate, select [Yes] under [Size Correction].

If [Size Correction] is applied, the white plate will become slightly smaller.

8. To close the window, click [OK].

9. In the [Send to Device] window, click [Send].

The print data is sent to the printer, and then printing starts.

 RELATED LINKS 

・ Introduction to FlexiDESIGNER

・  P. 87 Print Parameters (FlexiDESIGNER)

Quality Improvement Section

224  Frequently Asked Questions

https://downloadcenter.rolanddg.com/BD-8


Printing on an Uneven Surface

Print in distance mode if, for example, the print surface is uneven by 2 mm (0.08 in.) or more.

After creating print data with FlexiDESIGNER, click [Print parameters] and select [Generic Distance] or
[Generic Distance with Primer] from [Quality Settings]>[Media Type] on the [Quality] tab.
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Printing on Transparent Smartphone Cases

When printing on a transparent smartphone case, carry out the following operations to prevent UV light
reflected off the inside of the object from striking the print head surface. Carrying out these operations
reduces the frequency of maintenance that uses ink, thereby reducing ink consumption.

Use the following link to view a reference video for this procedure. We recommend that you view this vid-
eo to understand the overall flow of work.

https://youtu.be/ednqUzLCRhI

• Before printing on a transparent smartphone case, affix masking tape to the entirety of one long side
of the case ( ) as shown in the figure. If any masking tape extends past the side of the smartphone
case, fold this tape into the inside of the case ( ).

1

2

• When placing a transparent smartphone case on the flat table, orient the case vertically, positioning
on the right the side where masking tape is affixed.

OK NG

• When arranging multiple transparent smartphone cases for printing, ensure there are no gaps between
the cases.
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 RELATED LINKS 

・  P. 103 Printing on Smartphone Cases
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Printing Using Commercially-available Application Software

This is the printing procedure for printing by utilizing existing data (.ai, .pdf, etc.) or by using com-
mercially-available application software (Adobe Illustrator, CorelDRAW, etc.).

Procedure

1. Create print data using commercially-available application software.

Save the file in a file format that can be imported into VersaWorks (PDF, EPS, and similar formats).

2. Set up the object.

3. Follow the procedure below to start VersaWorks.

(1) Start Roland DG Connect Hub.

• Windows 11

i. Click [Start]>[All apps].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

• Windows 10

i. Click [Start].

ii. From the list of apps (programs), click [Roland DG Corporation]>[Roland DG Connect
Hub].

(2) Click the machine (BD-8) to use.

(3) Click [Open] for VersaWorks.

4. Use VersaWorks to print with various settings configured.

• If the machine is not registered, refer to the Installation Guide and register the machine.

• For information on how to use VersaWorks, see the VersaWorks Help.

 RELATED LINKS 

・ BD-8 Installation Guide

・ VersaWorks Help
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You can check notifications by clicking  on the Utility home screen. When there are notifications, their
number is displayed on the icon.

[When output, cleaning, and other operations are completed, discard the dis-
charged fluid.]

This message appears when a certain amount of discharged fluid collects in the drain pack.

Remove the drain cartridge, and then dispose of the discharged fluid as directed in the Utility window.

At the time this message is displayed, the drain pack has not reached the limit of its use. It can continue
to be used if, for example, a replacement drain pack is not readily available.

However when the drain pack has reached its service limit, [Replace the drain pack.] is displayed. If this
error appears, the drain pack can no longer be used, so if [When output, cleaning, and other operations
are completed, discard the discharged fluid.] appears, dispose of the discharged fluid as soon as possi-
ble.

 RELATED LINKS 

・  P. 188 Replacing the Drain Pack

[The drain cartridge was removed.]

This message appears when the drain cartridge is removed.

When disposing of discharged fluid is finished, install the drain cartridge as soon as possible.

This message appears when the protrusion on the drain cartridge is damaged.

If the protrusion circled below is damaged by dropping or other causes, the drain cartridge cannot be rec-
ognized as having been installed.

Replace the drain cartridge with a new one.

[The time for manual cleaning has arrived.]

This message appears when it is time to perform manual cleaning.

Click  for [The time for manual cleaning has arrived.] and perform manual cleaning.

 RELATED LINKS 

・  P. 167 Manual Cleaning

Notifications
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[Perform manual cleaning.]

This message appears if you continue to use the machine without performing manual cleaning even
after [The time for manual cleaning has arrived.] appeared.

You will not be able to set up the object if this notification is displayed.

Click  for [Perform manual cleaning.] and perform manual cleaning.

If you attempt to perform setup, the [Manual cleManual Cleaning Required for Printinganing required]
message appears. Click [OK] to switch to the manual cleaning screen.

[The time for wiper replacement has arrived.]

This message appears when it is time to replace the wiper.

Click  next to [The time for wiper replacement has arrived.] to replace the wiper.

 RELATED LINKS 

・  P. 192 Replacing the Wiper

[The time for felt wiper replacement has arrived.]

This message appears when it is time to replace the felt wiper.

Click  next to [The time for felt wiper replacement has arrived.] to replace the felt wiper.

 RELATED LINKS 

・  P. 194 Replacing the Felt Wiper

[The time for cap top replacement has arrived.]

This message appears when it is time to replace the cap top.

Click  next to [The time for cap top replacement has arrived.] and replace the cap top.

 RELATED LINKS 

・  P. 196 Replacing the Cap Top

[Print head protection mode has activated.]

This message appears when the ink in use may not be a product specified by Roland DG Corporation.

To obtain optimal performance, we recommend that you use ink specified by Roland DG Corporation. To
purchase ink, contact your authorized dealer.

[The time for ink mixing has arrived.]

This message appears when the white ink needs to be mixed.

Notifications
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Procedure

1. Click  under [The time for ink mixing has arrived.].

2. Pull out the white ink cartridge, and shake the ink cartridge 50 times (about 20 seconds) horizontally
with a stroke length of around 5 cm (1.97 in.) from each end of the ink cartridge before reinserting it.

3. When the [Was the white ink mixed?] window appears, click [Yes].

[The connection to the unit was lost.]

This message appears when one of the following situations is detected.

• The main power of this machine switches off.

• The IP address of this machine is changed.

• The LAN cable connecting this machine and the computer is disconnected.

Check the status of this machine, and then perform a recovery action. If the main power is left off, the
automatic maintenance function will not be able to operate, which may result in malfunctions. Always
keep the main power switched on.

[There is ink that has expired.]

This message appears when there are ink cartridges that have expired.

Procedure

1. Click the Notifications window.

The Ink Information window is displayed.

2. Replace any ink cartridges that have expired.

 RELATED LINKS 

・  P. 185 Replacing Ink Cartridges

[The time for manual cleaning of the UV lamp has arrived.]

This message appears when it is time to perform manual cleaning.

Click  for [The time for manual cleaning of the UV lamp has arrived.], and perform cleaning of the

UV lamp.

 RELATED LINKS 

・  P. 174 Cleaning the UV-LED devices
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[Ink Cartridge Error]

This message appears when one of the following ink cartridge errors is detected.

When an error occurs, the , , , or  icon is displayed next to the corresponding ink type on the screen.

MEMO

Implement appropriate countermeasures according to the error.

• When ink runs out

:[Ink has run out.]

Replace the ink cartridge with a new one.

• When little ink remains

:[Remaining ink level low.]

Printing is not possible if there is no ink. If this message appears, prepare a replacement ink car-
tridge.

• When ink has expired

:[There is ink that has expired.]

Although you can print with expired ink, it may lead to the following problems and malfunction.
We recommend replacing ink when this message appears.

• Ink leaks from the ink cartridge.

• The ink viscosity increases, leading to ink discharge issues (which may result in decreased output
quality).

• The ink hardens, leading to printer malfunctions.

• When an ink cartridge is removed

:[Ink cartridge was removed.]

Load the removed ink cartridge.

• When an ink cartridge with the incorrect color is loaded

:[Incorrect ink cartridge was loaded.]

Remove the incorrectly loaded ink cartridge, and then load the correct ink cartridge.

When you remove an ink cartridge, : [Ink cartridge was removed.] is displayed.

[Cover Open Error]

Front cover, maintenance cover or both covers are open.

For safety, the machine may stop if a cover is opened during operation.

Close all the covers.

[Manual Cleaning Tool Error]

This is displayed if the attached manual cleaning tool is detected when the sub power is on or when the
object is being set up. Immediately remove the manual cleaning tool.

ERROR
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[Rotary Mode Mismatch Error]

This is displayed when the rotary axis unit is attached or removed (the connector is disconnected or
connected) without using the Rotary Axis Unit Attachment/Removal menu. It is also displayed for a
connector connection failure.

When attaching or removing the rotary axis unit, be sure to do so from [Preferences]>[Rotary Unit At-
tachment/Removal]. Also be sure to connect the connector securely when attaching.

[Flat Table Height Error]

This message appears when the head gap sensor comes in the contact with the object.

It is displayed when the object, fixing tape, a retainer, or similar comes in contact with the head gap sen-
sor during non-printing operations.

It is displayed and printing stops when a height error is detected for an object during printing when the
clearance setting is [Stop].

It is displayed and printing stops if a height error for the object is detected during printing when the clear-
ance setting is [Readjust] and the problem does not resolve even when the table was lowered to the [Max-
imum Value (Threshold)].

In all of these cases, make sure that the object is set up correctly or that the size of the object does not
exceed the size that can be loaded. Set up the object correctly, or load a printable object of the size that
can be loaded.

[Print Data Larger Than Printing Area]

This message is displayed when there is not enough printing area for the print data.

To continue printing without changing the printing area or the print data, click [Yes]. The portion extend-
ing beyond the print area will not be printed.

To cancel printing, click [No]. Make the printing area wider or replace the object with a larger object, and
then send the data again.

[Insufficient Printing Area]

This message is displayed when there is not enough printing area for the test pattern of the nozzle
drop-out test or alignment marker printing.

Click [OK] to cancel printing. Then set the printing area again.

[Manual cleManual Cleaning Required for Printinganing required]

This message appears when the user attempts to set up the object while [Perform manual cleaning.] is
displayed. Click [OK] to switch to the manual cleaning screen. Perform manual cleaning.

[Replace the drain pack.]

This message appears when the amount of discharged fluid in the drain pack reaches the specified
amount.

Replace the drain pack that is inside the drain cartridge.

ERROR
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When the drain cartridge is detached, the error message changes to [The drain cartridge was removed.].

MEMO

ERROR
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[Service Call: ]

This is displayed when an unrecoverable error has occurred that requires repair by a service technician.
Note the number displayed in Utility, and then switch off the main power. After you switch off the power,
inform your authorized dealer of the number that appeared in the Utility window.

[Motor Error: ]

A motor error occurred.

Operation cannot be continued. Turn off the sub power. Next, eliminate the cause of the error, then imme-
diately switch on the sub power.

If the machine is allowed to stand with the error uncorrected, the print heads may dry out and become
damaged. This error may be caused by the object or the manual cleaning tool being set up incorrectly.

[Print Head Dry-out Error]

This message appears when the print heads are forced to the home position to prevent them from
drying out.

Operation cannot be continued. Switch the sub power off, and then back on.

[Low Temperature Error: ]

The internal temperature of the machine has fallen below that at which it can operate.

This message appears when the temperature falls to 5°C (41°F) or lower during startup or to 2°C (35.6°F)
or lower during operation.

Operation cannot be continued. Turn off the sub power.

Bring the installed location to a temperature at which operation is possible (20°C to 32°C [68°F to
89.6°F]), allow the machine to come to room temperature, and then turn on the power.

 RELATED LINKS 

・  P. 50 Power Supply Operations

[High Temperature Error: ]

The internal temperature of the machine has risen above that at which it can operate.

This message appears when the temperature rises to 42°C (107.6°F) or higher during startup or operation
(when recovering from sleep mode).

Operation cannot be continued. Turn off the sub power.

Bring the installed location to a temperature at which operation is possible (20°C to 32°C [68°F to
89.6°F]), allow the machine to come to room temperature, and then turn on the power.

 RELATED LINKS 

・  P. 50 Power Supply Operations

Fatal Error

236  Utility Notification/Errors/Fatal Errors



[Pump Stop Error]

This message appears when an ink cartridge is pulled out during pump operation, such as during clean-
ing, and is left in this state for 10 minutes or more.

Operation cannot be continued. Switch the sub power off, and then back on.

[Manual Cleaning Tool Error]

This is displayed if the attached manual cleaning tool is detected at a time other than when the sub power
is on or when the object is being set up. Remove the manual cleaning tool, and then turn the sub power
off and on again.

[Emergency Stop Error]

This message appears when the emergency stop button is pressed. The sub power LED is lit in red.

Procedure

1. Eliminate the cause of the emergency stop button being pressed.

2. Turn the emergency stop button clockwise until it stops turning, and then release the button.

If the button is pulled out toward you, it is released.

3. Hold down the sub power button for one second or longer to turn off the sub power. Repeat to turn on
the sub power.

The machine recovers from the emergency stop status.

4. Perform a nozzle drop-out test.

Perform cleaning as necessary.

 RELATED LINKS 

・  P. 64 Performing a Nozzle Drop-out Test

・  P. 160 Action Taken When Dot Drop-out or Dot Displacement Occur

Fatal Error
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When moving the machine from its installation location, do so after performing [Ink Circulation] and se-
curing the flat table and the print-head carriage.

Procedures from Preparing to Move to Reinstallation

If an object is dropped behind the flat table, search for it with all power switches turned off.
Otherwise sudden movement of the machine may cause injury.

CAUTION

Important notes on moving

• Once the preparations for moving the machine are complete, move the machine promptly and turn on the machine
as soon as possible after the machine is relocated. If you leave the machine alone without turning it on, the precipi-
tated ink will coagulate and result in problems such as the clogging of the print heads.

• When moving the machine, keep it at a temperature between 5 to 40˚C (41 to 104˚F) and at relative humidity be-
tween 20 to 80% (with no condensation). Failure to do so may result in malfunction.

• Handle the machine with care when moving it, keeping it level (not tilted at an angle) and preventing it from strik-
ing other objects.

• When transporting in a vehicle, avoid placing machine on a tilted surface, such as on a seat, and keep the machine
in a level state.

IMPORTANT

Procedure

1. On the Utility home screen, click .

2. Click [Execute] under [Maintenance]>[Ink Circulation].

This operation circulates the ink. This procedure will take several minutes.

3. Follow the procedure below to move the flat table to its lowest position.

Lower the flat table using the rotary axis unit's attachment/removal menu. If the rotary axis unit is
installed, remove it.

P. 131 Removing/Attaching Optional Items (OA-RA-8)

(1) Click [Execute] under [Preferences]>[Rotary Unit Attachment/Removal].

The flat table moves around the center position in the vertical direction.

(2) Open the front cover.

(3) When the [Attach or remove the rotary axis unit.] window appears, click [Next].

(4) When [Close all the covers.] is displayed, close the front cover, and then click [Finish].

The flat table moves to its lowest position.

4. Turn off the sub power, and then turn off the main power.

5. Open the front cover, and then remove the maintenance cover.

6. Remove the retainer (A) for the print-head carriage and the retainer (B) for the flat table.

Remove the retainers using the included hexagonal wrench.

Preparing to Move the Machine
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7. Push the flat table and then move it until it comes into contact with the back.

Move the flat table slowly.

IMPORTANT

8. Secure the print-head carriage and flat table with their retainers.

• Print-head carriage

Work carefully so that you do not drop the bolts.
If a bolt falls under the flat table, pick up the bolt according to the following guidelines.
1. Move the flat table back and forth by hand to look for the bolt.

If you cannot find the bolt, perform the following operation to search the underside of the flat table.
2. Move the flat table up as instructed in the guidelines for setting up thin media, such as nozzle drop-out

test paper.

MEMO

a. Place the bolt on the long side of the hexagonal wrench.

Use the bolt that was used to attach this retainer.

b. Place the retainer in the position shown in the figure.

c. Using the hexagonal wrench with the bolt attached, temporarily tighten the upper right of
the retainer.

Preparing to Move the Machine
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d. Temporarily tighten the remaining three locations.

e. Push the retainer to the right, and then fully tighten the bolts.

Tighten the bottom two locations lightly. Overtightening may result in bending of the mounting fix-
ture.

IMPORTANT

• Flat table

a. Place the retainer for the flat table in the position shown in the figure.

Place the retainer so that the protrusion (A) fits into the hole.

b. Tighten the screws while pushing the retainer to the back.

Use the screws that were used to attach this retainer.

Preparing to Move the Machine
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9. Attach the maintenance cover, and then close the front cover.

• Push the maintenance cover until the magnets adhere.

• Secure the front cover with masking tape or similar material to prevent it from opening during
transport.

10. Unplug the power cable and the Ethernet connector.

11. Move the machine as soon as possible.

12. After moving the machine, immediately install it.

13. Remove the print-head carriage and the flat table retainer.

(1) Open the front cover, and then remove the maintenance cover.

(2) Remove the retainer for the print-head carriage and the retainer for the flat table.

Remove them in the reverse order of step 8.

(3) Install the removed retainers (x 2) in the positions shown in the figure.

(4) Attach the maintenance cover, and then close the front cover.

14. Turn on the main power, and then turn on the sub power.

This completes the move operation.

Preparing to Move the Machine
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Outer Dimensions

a 911 mm (35.87 in.) d 586 mm (23.07 in.) g 768 mm (30.24 in.)

b 580 mm (22.83 in.) e 393 mm (15.47 in.) h 194 mm (7.64 in.)

c 26.2 mm (1.03 in.) f 32 mm (1.26 in.) i 173 mm (6.81 in.)

Dimensional Drawings
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Flat Table Dimensions

A: M4 holes for fixing rotary axis unit (OA-RA-8)
When the rotary axis unit is not in use, they can be used for securing a jig.

B: Do not use holes within the white line.

C: M4 holes (six locations marked with *)
They can be used for securing a jig.

a 0 mm (0 in.) g 182 mm (7.17 in.) m 19 mm (0.75 in.)

b 7.5 mm (0.30 in.) h 202 mm (7.95 in.) n 26 mm (1.02 in.)

c 15 mm (0.59 in.) i 225 mm (8.86 in.) o 50 mm (1.97 in.)

d 62 mm (2.44 in.) j 232.5 mm (9.15 mil) p 150 mm (5.9 in.)

e 82 mm (3.23 in.) k 8 mm (0.31 in.) q 174 mm (6.85 in.)

f 120 mm (4.72 in.) l 11 mm (0.43 in.) r 189 mm (7.44 in.)

Dimensional Drawings
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Printing method Piezo ink-jet method

Attachable objects
to be printed on

Width Max. 240 mm (9.4 in.)

Length Max. 178 mm (7 in.)

Thickness Max. 102 mm (4 in.)

Weight Max. 3 kg (6.6 lb.)

Maximum printing width/printing length Max. 210 × 148 mm (8.2 in. × 5.8 in.)

Ink Type ECO-UV (EUV5) 220 ml cartridge

Color Five colors (cyan, magenta, yellow, black, and white) and primer

Ink-curing unit Built-in UV-LED lamp

Printing resolution (dots per inch) Max. 1,440 dpi

Connectivity Ethernet (100BASE-TX/1000BASE-T, automatic switching)

Power-saving function Automatic sleep feature

Rated input 100 - 240 Va.c. 50/60 Hz 1.1 A

Power consumption During operation Approx. 90 W

Sleep mode Approx. 30 W

Acoustic noise level During operation 59 dB (A) or less

During standby 52 dB (A) or less

Dimensions (Width × Depth × Height) 768 mm × 586 mm × 580 mm (30.3 in. × 23.1 in. × 22.9 in.)

Weight 61 kg (134.5 lb.)

Environment During operation*1 Temperature: 20 to 32°C (68 to 89.6°F) (22°C [71.6°F] or higher recommended)
Humidity: 35%RH to 80%RH (no condensation)

Not operating Temperature: 5°C to 40°C (41°F to 104°F)
Humidity: 20%RH to 80%RH (no condensation)

Included items Power cord, cleaning liquid, User's Manual, software (FlexiDESIGNER VersaSTUDIO Edi-
tion, VersaWorks, Roland DG Connect), etc.

 

*1 Operating environment
(1): Use in an operating environment within this range.

F
C

68 80.6 89.6
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